Report Studio

Introduction

Elisabetta Zodeiko
2/25/2012
# Table of Contents

1. Report Studio Overview ................................................................. 6
   - Course Overview ........................................................................ 7
   - Princeton Information Warehouse ........................................... 8
   - Inside Cognos Connection ...................................................... 9
   - Accessing Report Studio .......................................................... 11
   - The Report Studio Windows .................................................. 16
   - Insertable Objects Window ..................................................... 17
   - Source Tab ............................................................................. 18
   - Data Items Tab ................................................................. 19
   - Toolbox Tab ......................................................................... 20
   - Properties Window ............................................................. 21
   - Report Window .................................................................... 22
   - Explorer Bar ........................................................................ 25

2. Creating and Modifying a Report ................................................... 27
   - Creating a Report in Report Studio ....................................... 29
   - Validating a report ............................................................. 32
   - Saving a report ................................................................. 34
   - Removing a Column .......................................................... 35
   - Source Tab vs. Data Items Tab ............................................. 36
   - Sorting ............................................................................... 38
   - Hiding Columns .................................................................. 43
   - Rearranging Columns ......................................................... 46
   - Adding a Column .............................................................. 47
   - Changing the Title ............................................................. 49

3. Grouping and Aggregation ............................................................. 53
   - Grouping a List Report ......................................................... 55
   - Level Spanning ................................................................. 59
   - Sections ............................................................................ 64
   - Page Breaks ........................................................................ 67

4. Calculations ............................................................................. 73
Calculations ........................................................................................................................................................75
Adding a Calculated Column ........................................................................................................................................76
Understanding Aggregation ........................................................................................................................................80
Adding Summary Totals to a Footer (Totaling a Column) ..........................................................................................81
Remove the Summary Footer ........................................................................................................................................84
Grouped Summary Footers ..........................................................................................................................................85
Summary Calculation Without Detail And Find the Average ..........................................................................................89

5. Filters .................................................................................................................................................................94
Concepts .................................................................................................................................................................95
Opening the Filters Dialog Window ..........................................................................................................................96
The Filters Dialog Window ..........................................................................................................................................97
Detail Filter Expression ...............................................................................................................................................100
Filtering on a Single Item from the Source (Source tab) ..........................................................................................106
Filtering on a Single Item from the Data Items Tab .................................................................................................114
Filtering on Multiple Items (Using “in”) ..................................................................................................................123
Filtering on a Date Range (Using “between”) ...........................................................................................................128
Filtering Text (Using “starts with”) ........................................................................................................................131
Filter Text (Using “contains”) .....................................................................................................................................137
Filtering using “Like” and a Wildcard ........................................................................................................................139

6. Prompts ...............................................................................................................................................................143
Parameters and Prompts .............................................................................................................................................145
Building a Parameter Filter .........................................................................................................................................148
Prompt Pages with Prompts .........................................................................................................................................155
Use a Parameter in Formatting .....................................................................................................................................162
Identify the Query and Parameter Filter ..................................................................................................................167
Prompts – Selecting Multiple Items in the Same Prompt ..........................................................................................170
Prompt Button ..........................................................................................................................................................175

7. Formatting Reports .............................................................................................................................................178
Building a Report .......................................................................................................................................................180
Data Formats ............................................................................................................................................................181
Text Formats ............................................................................................................................................................185
Adding Headers and Footers .........................................................................................................................................187

Report Studio Introduction
Princeton University

Report Studio Introduction

Formatting the Title ..........................................................................................................................................190
Adding a New Page ...........................................................................................................................................193
Understanding Select Ancestor ........................................................................................................................196
Running a report in PDF ...................................................................................................................................200
Adding Graphics ...............................................................................................................................................203

8. Creating Crosstab & Mail merge/Letter Reports ........................................................................... 205
   Crosstab Reports ........................................................................................................................................207
   Converting a List Report into a Crosstab ...................................................................................................208
   Crosstab Template ......................................................................................................................................213
   Nested Crosstabs .......................................................................................................................................216
   Crosstabs with Totals ...................................................................................................................................219
   Creating a Mail merge/Letter-type Report Using a Blank Report .............................................................221
1. **Report Studio Overview**

   Course Overview

   Princeton Information Warehouse

   Inside Cognos Connection

   Accessing Report Studio

   The Report Studio Windows

   Insertable Objects Window

     Source Tab

     Data Items Tab

     Toolbox Tab

   Properties Window

   Report Window

   Explorer Bar
Course Overview

In this course, students will use the IBM Cognos Report Studio tool to learn different report writing techniques, including creating, sorting, filtering, prompting, calculating, and formatting data. Lessons focus on linear report creation, independent of any specific data set.

Note: All Report Writers must use Microsoft Internet Explorer (IE) as their browser. Report Studio and Query Studio require Active X plug-ins which only IE supports.

Performance goals
Upon successful completion of this course, students will have an understanding of:

- The Princeton Information Warehouse environment
- The delivered IBM Cognos report writing tool, Report Studio
- Creating, editing, and saving reports using Report Studio, within context of the Princeton Information Warehouse
- Linear report writing, regardless of data set
- Report writing techniques, including sorting, filtering, prompting, calculating, and formatting data
Princeton Information Warehouse

The Princeton University “Information Warehouse” is a term describing a reporting data repository available to the Princeton Community. Consumers of this data can access reports through a delivered IBM Cognos tool, “Cognos Connection”, or simply, “Cognos”. Data sets inside the Information Warehouse (IW) accurately represent information in each one’s corresponding source, or “Source System”. However, all Source Systems, such as PeopleSoft Financials, or Time Collection, feed their data into IW reports, on a nightly basis. Thus, information inside the IW will be incongruent to the same information found in the corresponding Source System, by a difference of twenty-four hours.

The Information Warehouse Site

The Princeton University Information Warehouse (IW) site communicates useful information to the Princeton Community, including:

1. Who to contact to gain access to reports
2. Cognos system outages and downtimes
3. Data loading discrepancies

The URL to the Princeton IW site is:  http://www.princeton.edu/iw

Logging into Cognos Connection

To log into the Cognos Connection tool, or the “Information Warehouse”, click on “Enter the Information Warehouse” link, found on the IW homepage. You will need a valid Princeton Username and Password.
Inside Cognos Connection

Once logged into Cognos Connection (Cognos), Report Studio users will see Yellow and Blue folders on the Public Folders Tab.

Blue Package vs. Yellow Reports Folder

- A Yellow Reports Folders contain all reports for a given data set.
- A Blue Package Folder is the Cognos connection to the database for any given data set, and contains a business view of the data that is used to create reports.
  - The term “Package” is associated with a Blue Folder because any Blue Folder is the result of a published Data Set from the Cognos Developer tool, Framework Manager. For example, an HR data set is created in the Framework Manager tool by OIT, the data is published to Cognos Connection and is accessible to Report Writers through the Blue Folder.
  - No reports are ever saved in any Blue Package Folders.

Public Folders Tab vs. My Folders Tab

- The Public Folders Tab displays all Yellow Reports Folders and Blue Package Folders.
- The My Folders Tab is a User’s secured area within Cognos. Only the individual User can place and access items inside My Folders. Even Cognos Administrators have no access to a person’s My Folders area.
Yellow Reports Folder – Inbox

The Inbox folder is the holding area for reports written by report writers, allowing Package Custodians to test reports before moving them to the Report Viewer area within the Yellow Reports Folder. All report writers have the ability to save reports here, also known as having “write” abilities to the Inbox.

Report Viewer area: Anyone with Report Viewer access to a Yellow Reports folder can view reports in this area. Only Package Custodians can save or move reports to this area.
Accessing Report Studio

There are two ways to access Report Studio:

1. Opening a report directly through Report Studio.
2. Opening Report Studio first, and then choosing to work in an existing report or begin writing a new report.
Opening a Report with Report Studio

Editing or modifying reports that have already been created saves time by not having to recreate the same underlying items over and over in each new report. An efficient time saver is to open a report, which can serve as a “template”, then modify and save it under a different name, within either the Inbox folder or My Folders location.

GOAL: To open an existing report.

STEPS:

1. From the Public Folders tab, click on Cognos 8 Training – Reports.

2. Click the Report Studio Icon located to the right-side of the report name.

3. Report Studio will open with the chosen report’s specifications along with the correct underlying data source.
Opening Report Studio Directly:

Report Studio can be opened first, directly from the **Launch** button on the Public Folders menu, giving you the opportunity to first choose an underlying data source.

**GOAL:** To open Report Studio directly from the Public Folders Menu

**STEPS:**

1. On the Public Folders tab, in the upper-right corner menu-bar, click **Launch > Report Studio.**

2. In the new window, choose the Cognos 8 Training Blue Package Folder.

   If the Blue Package is a recently chosen item, you can select it from this list of “Recently used packages”.

---

Report Studio Introduction
3. The Report Studio Welcome window opens.

4. Click **Open an existing report or template**.

5. In the new drop-down menu, select Public Folders, then navigate to the Cognos 8 Training – Reports **Yellow** Folder.

6. Choose the **New Jersey Employee** report and click **Open**.
7. The report opens.
The Report Studio Windows

Report Studio is comprised of several windows and toolbars that are used to create or modify the report:

- Insertable Objects Window
- Source Tab
- Data Items Tab
- Toolbox Tab
- Properties Window
- Report Window
- Report Studio Toolbar
- Explorer Bar

Each of these windows and toolbars is described on the following pages.
Insertable Objects Window

The Insertable Objects pane is where the building and report modification takes place. An object is any item in a report, such as text, a picture, list, table, etc. The Insertable Objects pane consists of three tabs:

- **Source tab** – Displays all of the query items that are in the model. The query items can be added to the report.

- **Data Items tab** – Once an item is added to the report, it is shown on the data items tab. The tab displays all of the queries that are currently in the report. Use this tab to quickly find items in your report instead of navigating through the entire model.

- **Toolbox tab** – Contains the objects that you can add to your report.
**Source Tab**

The Source tab displays all of the objects available in the data mode, including query subjects, and query items within, and any delivered, pre-written filters. Opening each query subject will display the query items, or fields, within each query subject.
Data Items Tab

The Data Items tab displays all of the queries that are currently used in the report. Use this tab to quickly find items used in your report instead of navigating through the entire data model.
Toolbox Tab
Contains all of the objects you can add to your report. (The screen shot does not show all the available items. You will need to scroll down to see the remaining items.)
Properties Window

The Properties window allows you to change the appearance or behavior of items within the report. For example, you can manipulate the Text Source, Data, Color and Background, Text, Position, etc. of a Text Item in the report. (All objects in the report, including the title page and report pages, have properties that can be edited.)
Report Window

The Report window contains the area in which the report layout is displayed as it is being created.
## The Report Studio Toolbars

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New.</strong></td>
<td>Starts a new report.</td>
</tr>
<tr>
<td><strong>Open.</strong></td>
<td>Opens a previously created report.</td>
</tr>
<tr>
<td><strong>Save.</strong></td>
<td>Saves a report to Cognos Connection.</td>
</tr>
<tr>
<td><strong>Cut.</strong></td>
<td>Removes an object from the report and places it on the clipboard (usually to paste it elsewhere in the report).</td>
</tr>
<tr>
<td><strong>Copy.</strong></td>
<td>Copies an object (without removing it from its current location). Used in conjunction with Paste.</td>
</tr>
<tr>
<td><strong>Paste.</strong></td>
<td>Adds an object to a new location. (Used in conjunction with Cut or Copy).</td>
</tr>
<tr>
<td><strong>Delete.</strong></td>
<td>Removes an object.</td>
</tr>
<tr>
<td><strong>Undo.</strong></td>
<td>Goes back to the previous step.</td>
</tr>
<tr>
<td><strong>Redo.</strong></td>
<td>Goes forward (can only be used after using Undo).</td>
</tr>
<tr>
<td><strong>Validate Report.</strong></td>
<td>Check that the syntax within a report is correct.</td>
</tr>
<tr>
<td><strong>Show Specification.</strong></td>
<td>Shows the XML script that comprises the report.</td>
</tr>
<tr>
<td><strong>Run Report.</strong></td>
<td>Runs the report query and retrieves data. Click on the dropdown arrow to select different formats (Excel, PDF, etc.).</td>
</tr>
<tr>
<td><strong>Lock.</strong></td>
<td>Locks objects in a report, preventing editing or deletion.</td>
</tr>
<tr>
<td><strong>Unlock.</strong></td>
<td>Unlocks objects in a report so that they can be edited.</td>
</tr>
<tr>
<td><strong>Show Visual Aids.</strong></td>
<td>Shows or does not show icons related to different actions performed on the report, such as grouping and filtering.</td>
</tr>
<tr>
<td><strong>Directional Aids.</strong></td>
<td>Moves from one level of a Cognos Viewing window to another.</td>
</tr>
<tr>
<td><strong>Filters.</strong></td>
<td>Narrows down data in a report according to specified criteria.</td>
</tr>
<tr>
<td><strong>Suppress Data.</strong></td>
<td>Suppressing rows or columns without data in crosstab reports for a more concise view of a report.</td>
</tr>
<tr>
<td><strong>Sort.</strong></td>
<td>Organize data in either ascending or descending order, or removes the sort.</td>
</tr>
<tr>
<td><strong>Aggregate.</strong></td>
<td>Totals, counts, or averages grouped data. Other aggregates available are minimum and maximum.</td>
</tr>
<tr>
<td><strong>Group/Ungroup.</strong></td>
<td>Places like items together (or remove the like items from a grouping). Items must be grouped in order to total or perform other aggregate calculations.</td>
</tr>
<tr>
<td><strong>Pivot List to Crosstab.</strong></td>
<td>Convert a List report to a Crosstab report.</td>
</tr>
<tr>
<td><strong>Create Section.</strong></td>
<td>Creates a section from a grouped item. A section is identical to a group, except it is positioned above the list columns.</td>
</tr>
<tr>
<td><strong>Swap Rows and Columns.</strong></td>
<td>Exchanges the position of the rows and columns within the report.</td>
</tr>
<tr>
<td>Button Description</td>
<td>Function</td>
</tr>
<tr>
<td>--------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>List Headers &amp; Footers</td>
<td>Used to add, edit, or delete a header and footer on a list.</td>
</tr>
<tr>
<td>Insert Chart</td>
<td>Used to insert a chart onto the report page.</td>
</tr>
<tr>
<td>Build Prompt Page</td>
<td>Automatically builds a prompt, related filter, and prompt page</td>
</tr>
<tr>
<td></td>
<td>for any field in a report.</td>
</tr>
<tr>
<td>Drill Through Definition</td>
<td>Set up drill-through access in a source report to link two reports</td>
</tr>
<tr>
<td></td>
<td>containing related information.</td>
</tr>
<tr>
<td>Help</td>
<td>Access IBM Cognos Report Studio documentation.</td>
</tr>
<tr>
<td>Data Format</td>
<td>Changes the default format of a given field, for example, from a “Numeric” field to a “Text” field, or formatting a “Numeric” field to only display up to two decimal places.</td>
</tr>
</tbody>
</table>

**Text Formatting Buttons.** Use these buttons to format text within a report, including displayed field data.

**Table Formatting Buttons.** Use these buttons to format tables within a report.

**Conditional Formatting Buttons.** Use these buttons to format tables within a report.
Explorer Bar

The Report Studio window also contains an Explorer Bar that further allows navigation and manipulation of reports.

The **Explorer Bar** allows you to manipulate your report in three different ways:

- **Page Explorer** – Use this to change between title pages, report pages, and prompt pages, or to add new pages to the report.
- **Query Explorer** – Use this to modify queries within a report.
- **Condition Explorer** – Use this to change the appearance of the report based on specific criteria, such as all “Salaries” over $100,000 to be highlighted red.
2. Creating and Modifying a Report

Creating a Report in Report Studio

Validating a report

Saving a report

Removing a Column

Source Tab vs. Data Items Tab

Sorting

Hiding Columns

Rearranging Columns

Adding a Column

Changing the Title
Creating a Report in Report Studio

GOAL: To create a new report illustrating everyone affiliated with the University.

Linear Process: Identify all Affiliations.

STEPS:

1. From the Public Folders tab, in the upper-right corner menu-bar, click Launch > Report Studio.

2. In the new window, choose the Cognos 8 Training Blue Package Folder.

4. Click **Create a new report or template**

5. Select **List > OK**

6. In the **Insertable Objects** window, open **Cognos 8 Training Data** by clicking the plus sign or by double clicking on the name, **Cognos 8 Training Data**.

7. Open **Personal Data** table by clicking the plus sign or by double clicking on the name of the item.

8. Double-click **ID** to add it to the report.

9. Double-click **Last Name** and **First Name**.
10. **Double-click** the following items to add them to the report:
   - Country code
   - Street Address 1
   - City
   - State
   - Postal Code
   - Primary University Affiliation Description
   - Primary University Affiliation Group Description
   - Primary University Affiliation Status Description
Validating a report

GOAL: To validate report data.

STEPS:

1. Click the Validate icon in the toolbar.

2. The following message is displayed.

3. Click the Run Report icon to view the report.
4. Close the Report Viewer window by clicking the **Close** link in the upper right corner.
Saving a report

GOAL:  To save the current report.

STEPS:

1.  From the File menu, choose Save As.

2.  Click the My Folders icon on the left side of the window.

3.  In the Name field, name the report Personal Data report, followed by your initials.

4.  Click the Save icon.

5.  The report is saved with the new file name.
Removing a Column

Removing a column may be necessary if the information is no longer needed for reporting purposes, or if you want to produce a report but do not want the recipients to see certain details.

**GOAL:** To remove a column from the report using Delete.

**STEPS:**

1. Click the **Primary University Affiliation Status Description** column header (the last column).

2. Press the **Delete** key on the keyboard to remove column.
Source Tab vs. Data Items Tab

As you make changes to the report, the items from the Source tab, or from the data model, never change. The Source tab contains all the data available in the package, in the data model, whether you use it in your report or not. By contrast, the query represents query items, fields, used in your report. The query may or may not change as you edit your report, depending on the kind of modification you make. For example, when we used Delete to remove the column, in the exercise above, the column was deleted from the query, and no longer found on the Data Items tab.

To remove a column from the report, but not from the query, use the “cut” function to cut the column from the report page.

Tip: Cutting a column instead of deleting a column leaves the data item in the query, but does not display the column on the report page. Later in this chapter we will learn how to remove a column from the report while keeping it in the query.

GOAL: To examine the Source tab vs. the Data Items tab.

STEPS:

1. In the Insertable Objects window, click on the Data Items tab. Examine the Query.

Note: The Primary University Affiliation Status Description column that was just deleted, is not in the query, and not found on the Data Items tab.
2. Click on the **Source** tab. Scroll down in the Personal Data folder. Notice that many items, not in the report, are still in the data model, including the column we **deleted** from the report.
Sorting

**GOAL:** To sort report data. To add a multiple sort and to remove a sort.

**Linear Process:** To order our data by “Last Name”.

**STEPS:**

1. Click on the **Last Name** blue column heading in the report.

2. From the toolbar, click the **Sort** icon.

3. From the drop down, select **Sort Ascending**.

4. The **Sort Ascending** icon appears as an up-arrow in the first cell of the Last Name column.

   **Note:** When the point of the triangle points up, the column will be sorted in ascending order, from A to Z, or from smallest to largest for numeric data. When the point is down, the column will be sorted in descending order, from Z to A or from largest to smallest.

5. Click the **Run Report** icon.
6. Notice the sort order for the two rows with the Last Name “Amon.” The First Name “Shiren” appears above “Ze-Ke”.

7. **Close** the Report Viewer.
Multiple Sorts Within a Report

More than one column can be sorted within the same report. Additionally, one column can be sorted in reverse order of the other column(s) if desired. Currently, the primary sort is an ascending sort on Last Name. We will now change First Name to sort in descending order within Last Name.

1. Highlight the **First Name** column heading.

2. Click the **Sort** icon and select **Advanced Sorting**.

3. Drag over “First Name” from the **Data Items** window, and place the field under “Last Name” in the **Detailed Sort List** in the right-side pane.

4. Change the sort order to **Descending** by clicking once on the **Sort Order** button on the bottom of the window.

5. Click **OK**
6. Click the **Run Report** icon. Notice the change for the two rows with the Last Name “Amon.” The record containing the “First Name” of “Ze-Ke” now appears above the “Shiren” record.

<table>
<thead>
<tr>
<th>ID</th>
<th>Last Name</th>
<th>First Name</th>
<th>Country Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>000000701</td>
<td>Aden</td>
<td>Hitoshi</td>
<td>USA</td>
</tr>
<tr>
<td>000000779</td>
<td>Adler</td>
<td>Meiko</td>
<td></td>
</tr>
<tr>
<td>000000230</td>
<td>Agyeman</td>
<td>Annette</td>
<td>USA</td>
</tr>
<tr>
<td>000000666</td>
<td>Ahearn</td>
<td>Amy</td>
<td>USA</td>
</tr>
<tr>
<td>000000369</td>
<td>Ahmad</td>
<td>Heinz-Dieter</td>
<td>USA</td>
</tr>
<tr>
<td>000000166</td>
<td>Ahmed</td>
<td>Michael</td>
<td>USA</td>
</tr>
<tr>
<td>000000039</td>
<td>Aidoo</td>
<td>Roy</td>
<td>USA</td>
</tr>
<tr>
<td>000000600</td>
<td>Alatalo</td>
<td>Thomas</td>
<td></td>
</tr>
<tr>
<td>000000484</td>
<td>Alexander</td>
<td>Jiping</td>
<td>USA</td>
</tr>
<tr>
<td>000000023</td>
<td>Alyea</td>
<td>Mark</td>
<td>USA</td>
</tr>
<tr>
<td>000000905</td>
<td>Amerian</td>
<td>Access</td>
<td>USA</td>
</tr>
<tr>
<td>000000236</td>
<td>Amobi</td>
<td>Maria</td>
<td>USA</td>
</tr>
<tr>
<td>000000781</td>
<td>Amon</td>
<td>Ze-Ke</td>
<td>USA</td>
</tr>
<tr>
<td>000000708</td>
<td>Amon</td>
<td>Shiren</td>
<td>USA</td>
</tr>
<tr>
<td>000000120</td>
<td>Andler</td>
<td>Gregory</td>
<td>USA</td>
</tr>
<tr>
<td>000000235</td>
<td>Andrews</td>
<td>Waka</td>
<td>USA</td>
</tr>
</tbody>
</table>

7. **Close** the Report Viewer.
Removing a sort:

1. Click on the **First Name** column heading.

2. Click the **Sort** button and select **Don’t Sort**.

3. Click the **Save** button to save your changes to the report.
Hiding Columns

Now we will use Cut from the Edit menu to remove columns from the report. This effectively hides the columns, from the report page. Although the data is no longer displayed in the report, using Cut still retains the column in the query. This allows us to use the item for other purposes, such as sorting on the hidden column.

**GOAL:** To use Cut to hide a column.

**STEPS:**

1. **Ctrl-Click** on the Last Name and First Name column headings so that both columns are selected.

2. From the Edit menu, select **Cut**.

3. The Last Name and First Name columns are removed from the report.
4. Mouse-over the **Query Explorer** tab, and click on **Query1**. Notice that the Last Name and First Name columns are still in the Query.

[Image]

**Note:** You may also use the following methods to hide a column and sort on it even though it is not in the report.

- **Query Explorer**: Do not add the column to the report. Instead, click the Query Explorer bar and then click Query 1. From the Insertable Objects window, drag and drop the column into the Facts window. Highlight the column in the Facts window and change the Sort order in the Properties window.

- **Properties window/Box Type**: Add the column to the report and sort on it. Then highlight the column heading AND the column itself, and in the Properties window and select Box Type as None. This will also hide the column so it is not in the report.
5. **Run** the report. The report is still sorted by Last Name even though the column has been hidden.

<table>
<thead>
<tr>
<th>ID</th>
<th>Country Code</th>
<th>Street Address 1</th>
<th>City</th>
<th>State</th>
<th>Postal Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>000000701</td>
<td>USA</td>
<td>504 South 4th Ave</td>
<td>Chester</td>
<td>NJ</td>
<td>07930</td>
</tr>
<tr>
<td>000000779</td>
<td>USA</td>
<td>486 Fairfield Road</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>00000230</td>
<td>USA</td>
<td>19 Shirley Lane</td>
<td>Erie</td>
<td>PA</td>
<td>16505</td>
</tr>
<tr>
<td>00000666</td>
<td>USA</td>
<td>77 Van Sant Drive</td>
<td>East brunswick</td>
<td>NJ</td>
<td>08816</td>
</tr>
<tr>
<td>00000369</td>
<td>USA</td>
<td>42 Rolling Lane</td>
<td>Palo Alto</td>
<td>CA</td>
<td>94306</td>
</tr>
<tr>
<td>00000166</td>
<td>USA</td>
<td>12 Shell Turn</td>
<td>Salina</td>
<td>KS</td>
<td>67401</td>
</tr>
<tr>
<td>00000039</td>
<td>USA</td>
<td>99 Chesterfield</td>
<td>Stone Harbor</td>
<td>NJ</td>
<td>08247</td>
</tr>
<tr>
<td>00000060</td>
<td>USA</td>
<td>150 Locust Ave.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>00000484</td>
<td>USA</td>
<td>5 Tanager Lane</td>
<td>Golden Valley</td>
<td>MN</td>
<td>55416</td>
</tr>
<tr>
<td>00000023</td>
<td>USA</td>
<td>3 Kirk Avenue</td>
<td>Princeton</td>
<td>NJ</td>
<td>08540</td>
</tr>
<tr>
<td>00000905</td>
<td>USA</td>
<td>713 Lake Drive</td>
<td>Lawrenceville</td>
<td>NJ</td>
<td>08648</td>
</tr>
<tr>
<td>00000236</td>
<td>USA</td>
<td>116 Niagara Lane</td>
<td>Bloomfield Hills</td>
<td>MI</td>
<td>48301</td>
</tr>
<tr>
<td>00000981</td>
<td>USA</td>
<td>36 Juniper Row</td>
<td>Flower Mound</td>
<td>TX</td>
<td>75022</td>
</tr>
<tr>
<td>00000762</td>
<td>USA</td>
<td>9 Saylor Court</td>
<td>Woodside</td>
<td>CA</td>
<td>94062</td>
</tr>
<tr>
<td>0000120</td>
<td>USA</td>
<td>70 Clay Street</td>
<td>New York</td>
<td>NY</td>
<td>10022</td>
</tr>
<tr>
<td>00000235</td>
<td>USA</td>
<td>Post Office Box 261</td>
<td>Minersville</td>
<td>PA</td>
<td>17954</td>
</tr>
<tr>
<td>00000817</td>
<td>USA</td>
<td>133 Green Avenue</td>
<td>Huntington Station</td>
<td>NY</td>
<td>11746</td>
</tr>
<tr>
<td>00000272</td>
<td>USA</td>
<td>Post Office Box 5863</td>
<td>Newberry</td>
<td>SC</td>
<td>29108</td>
</tr>
<tr>
<td>00000647</td>
<td>USA</td>
<td>11 Edgehill Street</td>
<td>Houston</td>
<td>TX</td>
<td>77024</td>
</tr>
<tr>
<td>00000121</td>
<td>USA</td>
<td>2334 Strawberry Court</td>
<td>Woodstock</td>
<td>MD</td>
<td>21163</td>
</tr>
</tbody>
</table>

6. **Close** the Report Viewer.

**Note:** *Delete vs. Cut*

- **Deleting** a column by clicking the **Delete** icon removes the column from the report page and the data item from the query.

- **Cutting** a column by clicking the **Cut** icon removes the column from the report, but leaves the data item in the query.

*Use Cut for those times when you need to leave an item in the query, but do not wish to show it on the report page.*
Rearranging Columns

After running a report, or just viewing the query, it is easy for the user to change the way the columns appear in the report.

**GOAL:** To move the ID column.

**STEPS:**

1. Click the **ID** column heading to highlight it.

2. **Drag** the highlighted **ID** column heading to the end of the report, after Primary University Affiliation Group Description. Be sure to wait until there is a vertical, *triple-flashing* bar.

3. **Release** the mouse.

4. **Run** the report to view the new report layout.

5. **Close** the Report Viewer and then Save the report.
Adding a Column

Increasing the information in a report is easily accomplished by adding new columns to the report. There are several ways to add columns to a report:

- Double-clicking on the item.
- Right-clicking on the item and choosing Insert.
- Clicking and dragging the item to the report.

GOAL: To add “Full Name” to the report.

STEPS:

1. Make sure the **Country Code** column heading in the report is highlighted.

2. In the Insertable Objects window, in the Model tab, under Personal Data, locate **Full Name**.

3. Right-click on **Full Name** and click **Insert**.

4. **Full Name** has been added as the first column in the report.

5. Click **Run**.
6. **Close** the Report Viewer and **Save** the report.

**Note:** The new column will be placed before the highlighted column. If no column is highlighted the new column will be placed at the end of the report.
Changing the Title

The title area of the report is easily altered as the reporting changes are made within the body of the report. The title shows in the Report Viewer and also when the report is printed.

GOAL: To change the title.

STEPS:

1. In the Title area, double-click the Double click to edit text link.
2. In the Text window, type Personal Data Report.
3. Click OK.
4. **Run** the report.

5. **Close** the Report Viewer and **Save** the report.
Exercise

- Using the current report, delete the Full Name column.
- Add Birthdate and make it appear as the second-to-last column in the report.
- Add Last Name and First Name back in as the first two columns in the report. (Add these two fields from the Data Items tab.)
- Remove the Sort on Last Name.
- Instead, Sort Ascending on Birthdate.
- Hide the Birthdate column.
- Change the title to Personal Data report exercise.
- Save the Report as Personal Data report exercise.
- Run the Report.
3. Grouping and Aggregation

Grouping a List Report

Level Spanning

Sections

Page Breaks
Grouping a List Report

Grouping a column of data makes it easier to find data, as all like items are placed within the same grouping. After grouping data, the columns can have a count, total, average or the like applied to them.

GOAL: To group the columns.

Linear Process: Organize all of the records returned by Primary University Affiliation Description and Primary University Affiliation Group Description

STEPS:

1. Open the Personal Data Report.

2. Save the report as Personal Data Report grouped.

3. Move the Primary University Affiliation Description and Primary University Affiliation Group Description (the second to the last two columns) to the beginning of the report.
4. Run the report.  Note: the repeating data in the first two columns


6. Click once on the Primary University Affiliation Description column.

7. Click the Group/Ungroup icon. Notice the new icon in the Primary University Affiliation Description List Column Body.
8. **Run** the report. The first column is grouped.

9. **Close** the Report Viewer.

10. **Click** Save.
11. Click in the column heading of **Primary University Affiliation Group Description**.

12. Click the **Group/Ungroup** icon.

13. **Run** the report.

### Personal Data Report

<table>
<thead>
<tr>
<th>Primary University Affiliation Description</th>
<th>Primary University Affiliation Group Description</th>
<th>Full Name</th>
<th>Country Code</th>
<th>Street Address</th>
<th>City</th>
<th>State</th>
<th>Postal Code</th>
<th>ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee</td>
<td>Human Resources</td>
<td>Agyeman, Annette R.</td>
<td>USA</td>
<td>10 Shirley Lane</td>
<td>Erie</td>
<td>PA</td>
<td>16505</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ahmed, Michael G.</td>
<td>USA</td>
<td>12 Shell Turn</td>
<td>Saline</td>
<td>KS</td>
<td>67401</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Abou, Ray</td>
<td>USA</td>
<td>89 Chesterfield</td>
<td>Stone Harbor</td>
<td>NJ</td>
<td>08347</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ayala, Thomas</td>
<td>USA</td>
<td>150 Locust Ave</td>
<td>Princeton</td>
<td>NJ</td>
<td>08540</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Alley, Mark</td>
<td>USA</td>
<td>310k Avenue</td>
<td>Princeton</td>
<td>NJ</td>
<td>08540</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Amobi, Marcel I.</td>
<td>USA</td>
<td>116 Neogene Lane</td>
<td>Bloomfield Hills</td>
<td>MI</td>
<td>48030</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ander, Gregory G.</td>
<td>USA</td>
<td>79 City Street</td>
<td>New York</td>
<td>NY</td>
<td>10022</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Andrade, Walia</td>
<td>USA</td>
<td>Post Office Box 261</td>
<td>Mineville</td>
<td>PA</td>
<td>17954</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ankan, Kazukoui D.</td>
<td>USA</td>
<td>2324 Strawberry Court</td>
<td>Woodstock</td>
<td>MD</td>
<td>21102</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bahl, Jason</td>
<td>USA</td>
<td>82 Sycamore Court</td>
<td>Houston</td>
<td>TX</td>
<td>77003</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Barres, Steve SFC</td>
<td>USA</td>
<td>49 Fox Chase Run</td>
<td>New York</td>
<td>NY</td>
<td>100172302</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bay, John</td>
<td>USA</td>
<td>56 Alumnum Court</td>
<td>Morris Plains</td>
<td>NJ</td>
<td>07950</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bearce, Thomas</td>
<td>HIG</td>
<td>61 Rarvyn Drive</td>
<td>Lucky Plaza</td>
<td></td>
<td>07900</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bell, Natasha</td>
<td>USA</td>
<td>601 Bartetown Road</td>
<td>Laredo</td>
<td>TX</td>
<td>78044</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bellomo, Ronald</td>
<td>USA</td>
<td>8 James Court</td>
<td>Princeton</td>
<td>NJ</td>
<td>08540</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Benitez, Lyle R. S.</td>
<td>USA</td>
<td>5948 Terrace Avenue</td>
<td>Chesapeake</td>
<td>VA</td>
<td>23222</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Benton, Sarge</td>
<td>USA</td>
<td>883 Strawberry Lane</td>
<td>Cananoele</td>
<td>FL</td>
<td>32670</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Biller, Ruthie</td>
<td>USA</td>
<td>200 Ballen Court</td>
<td>Ann Arbor</td>
<td>MI</td>
<td>48105</td>
<td></td>
</tr>
</tbody>
</table>

14. **Page down** through the report or click **Bottom** to see the various types of data available.

15. **Close** the Report Viewer.

16. **Save** the report.
Level Spanning

Level Span controls how often the report creator or user chooses to show a particular item within a group. It is helpful to group all like records together, and have each record’s information appear on each line.

**GOAL:** To create a Level Span with citizenship data.

**STEPS:**

1. We will create a new report for this exercise. From the **File** menu, select **New**. Select **List** and click **OK**.

2. Open the **Citizenship Data** folder.
3. Add the following columns: **Country of Citizenship, Citizenship Status Description, Department Name** (from the Job Data Query Subject) and **ID** (from the Citizenship Data Query Subject).

![Diagram of report structure]

4. Save the report as **Level Spanning**.

5. **Run** the report.

<table>
<thead>
<tr>
<th>Country of Citizenship</th>
<th>Citizenship Status Description</th>
<th>Dept Name</th>
<th>ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>BRA</td>
<td>Alien Temporary/International</td>
<td>Human Resources</td>
<td>000000027</td>
</tr>
<tr>
<td>BRA</td>
<td>Alien Temporary/International</td>
<td>Security</td>
<td>000000021</td>
</tr>
<tr>
<td>DEU</td>
<td>Alien Temporary/International</td>
<td>Security</td>
<td>000000022</td>
</tr>
<tr>
<td>IND</td>
<td>Alien Temporary/International</td>
<td>Athletics</td>
<td>000000029</td>
</tr>
<tr>
<td>NPL</td>
<td>Alien Temporary/International</td>
<td>Security</td>
<td>000000023</td>
</tr>
<tr>
<td>SGP</td>
<td>Alien Temporary/International</td>
<td>Human Resources</td>
<td>000000028</td>
</tr>
<tr>
<td>TUR</td>
<td>Alien Temporary/International</td>
<td>Finance</td>
<td>000000030</td>
</tr>
<tr>
<td>USA</td>
<td>Citizen</td>
<td>Finance</td>
<td>000000024</td>
</tr>
<tr>
<td>USA</td>
<td>Citizen</td>
<td>Human Resources</td>
<td>000000025</td>
</tr>
<tr>
<td>USA</td>
<td>Citizen</td>
<td>Human Resources</td>
<td>000000026</td>
</tr>
<tr>
<td></td>
<td>Alien Temporary/International</td>
<td>Athletics</td>
<td>000000016</td>
</tr>
<tr>
<td></td>
<td>Alien Temporary/International</td>
<td>Athletics</td>
<td>000000018</td>
</tr>
</tbody>
</table>

6. **Close** the Report Viewer.

7. **Group** the first three columns.
8. **Run** the report. Notice the records are grouped, first by *Country of Citizenship*, then by *Citizenship Status Description*, then by *Dept Name*.

<table>
<thead>
<tr>
<th>Country of Citizenship</th>
<th>Citizenship Status Description</th>
<th>Dept Name</th>
<th>ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>BRA</td>
<td>Alien Temporary/International</td>
<td>Human Resources</td>
<td>0000000027</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Security</td>
<td>0000000021</td>
</tr>
<tr>
<td>DEU</td>
<td>Alien Temporary/International</td>
<td>Security</td>
<td>0000000022</td>
</tr>
<tr>
<td>IND</td>
<td>Alien Temporary/International</td>
<td>Athletics</td>
<td>0000000029</td>
</tr>
<tr>
<td>NPL</td>
<td>Alien Temporary/International</td>
<td>Security</td>
<td>0000000023</td>
</tr>
<tr>
<td>SGP</td>
<td>Alien Temporary/International</td>
<td>Human Resources</td>
<td>0000000028</td>
</tr>
<tr>
<td>TUR</td>
<td>Alien Temporary/International</td>
<td>Finance</td>
<td>0000000030</td>
</tr>
<tr>
<td>USA</td>
<td>Citizen</td>
<td>Finance</td>
<td>0000000024</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Human Resources</td>
<td>0000000025</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0000000026</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Alien Temporary/International</td>
<td>Athletics</td>
<td>0000000016</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Finance</td>
<td>0000000018</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0000000014</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>0000000015</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>0000000020</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Citizen</td>
<td>Security</td>
<td>0000000019</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Athletics</td>
<td>0000000017</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Facilities</td>
<td>0000000012</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Human Resources</td>
<td>0000000013</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Library Staff</td>
<td>0000000013</td>
</tr>
</tbody>
</table>

9. **Close** the Report Viewer.

10. In order for the *Citizenship Status Description* to repeat each time the *Dept Name* changes; the Level Span association must be changed.
11. Highlight the Citizenship Status Description column body and locate Group Span in the Properties window.

12. Click the word Group Span.

13. Click on the arrow which appears to the right.

14. Click Dept Name in the drop down list.

Note: Only other grouped fields will appear in the list.
15. **Run** the report and notice how the report has changed. (Citizen now repeats each time a new Dept Name is listed.)

![Level Spanning](image)

19. **Close** the Report Viewer.

20. **Save** the report.
Sections

Sections are similar to grouping; however, a section differs in the fact that it shows the query item as the heading of a section or area within the report.

GOAL:  To create a section based on Country of Citizenship.

STEPS:

1. We will first have to undo the **Level Spanning** property done in the previous exercise, so highlight the **Citizenship Status Description** column body and locate **Group Span** in the Properties window.

2. Click the word **Group Span**.

3. Click on the arrow which appears to the right.

4. Click **Citizenship Status Description** in the drop down list.

**Note:**  Only other grouped fields will appear in the list.
7. Highlight the **Country of Citizenship** column heading.

8. From the **Structure** menu, locate **Create Section**.

9. Click **Create Section**. Notice that the “Country of Citizenship” field is pulled out of the list and placed above it.
10. **Run** the report and notice that each time the Country changes, a new Country section is created.

11. **Close** the Report Viewer.

12. **Click Save**.

**Note:** A person’s “Country” record no longer repeats for each Citizenship Status Description, as it did in the Level Spanning Exercise. If you wish to have a section for each grouping (i.e. a section for Country and a “sub-section” for Citizenship Status Description within country), select both column headings in the report, and select **Create Section**.
Page Breaks

Report pages can be separated on designated grouped fields.

**Note:** A field must be **Grouped** or **Sectioned**, in order for Report Studio to use it for a page break.

**GOAL:** To page break the report on the **Country of Citizenship** field.

**Linear Process:** Each new “Country of Citizenship” record will start on a new page.

**STEPS:**

1. Save the Sections report as **Page Breaks**.
2. Mouse over the **Page Explorer** vertical bar.
3. Click on **Report Pages**.
4. Click *once* on **Page1**.
5. From the toolbox tab , drag over a Page Set and place it above Page1 in the Page Explorer.

6. Drag Page1 into the Detail Pages folder, so that Page1 appears below the Detail Pages folder.

7. Click once on Page Set1.

8. In the Properties section, click on the Query property.
9. Click the drop-down arrow which appears next to **Query 2**. Select **Query 1**.

10. Also in the **Properties** section, click on the **Grouping and Sorting** property.

11. Click the ellipses button.
12. In the new window, drag **Country of Citizenship** under the **Overall** section.

13. Click **OK**.

15. Notice that you must page down to see the next **Country of Citizenship** section.

<table>
<thead>
<tr>
<th>Citizenship Status Description</th>
<th>ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alien Permanent</td>
<td>000000337</td>
</tr>
<tr>
<td></td>
<td>000000537</td>
</tr>
<tr>
<td>Not Indicated</td>
<td>000000572</td>
</tr>
<tr>
<td></td>
<td>000000574</td>
</tr>
</tbody>
</table>


17. Save the **Page Break** report.
4. Calculations

Calculations

Adding a Calculated Column

Understanding Aggregation

Adding Summary Totals to a Footer (Totaling a Column)

Remove the Summary Footer

Grouped Summary Footers

Summary Calculation Without Detail And Find the Average
Calculations

Complex and involved calculations are possible within Report Studio. This chapter will focus on the easier and more commonly used calculations.

For instance, we can create a calculated column by multiplying one column with another. Grouping a column allows you to keep all the similar data together, and to add summaries for each group. Some of the summaries available are counting the number of rows, averaging the numbers in a group and totaling.

GOAL: To build a report to use within this chapter.

STEPS:

1. Click the **New** icon and select **List**.

2. Add **Full Name** and **Birthdate**.

3. Save the report as **Calc**.

Adding a Calculated Column

A calculated column is a column created by the user, because the column does not exist in the model.

**GOAL:** To create a new *Age* calculated column by using the existing *Birthdate* data item.

**Linear Process:** Calculate a person’s birthday, using the existing *Birthday* field from the model and a SQL function, in a new field named “*Age*”.

**STEPS:**

1. Click the **Toolbox** tab .

2. Click and drag a **Query Calculation** to the right of the Birthdate column.

3. In the **Create Calculation** window, under Name, type *Age*.
4. Click OK.

5. Click the Functions tab and open the Business Date/Time Functions folder. Scroll down and double-click _years_between to add it to the right.

6. Open the Common Functions folder and double-click current_date.

7. Type a comma and a space after current_date.

8. Click the Source tab and double-click Birthdate. Type a ) after Birthdate.
9. Click the **Validate** icon and make sure there are no errors.

**Note:** You can also type directly into the Expression Definition area.

10. Click **OK**.
11. Run the report.

### Princeton University Information Warehouse

<table>
<thead>
<tr>
<th>Full Name</th>
<th>Birthday</th>
<th>Age</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sherman, Mike</td>
<td>Oct 16, 1979</td>
<td>30</td>
</tr>
<tr>
<td>Wu, Paul SGT</td>
<td>Dec 13, 1974</td>
<td>35</td>
</tr>
<tr>
<td>Ho, Brian</td>
<td>Mar 20, 1976</td>
<td>34</td>
</tr>
<tr>
<td>Alyea, Mark</td>
<td>Apr 16, 1977</td>
<td>32</td>
</tr>
<tr>
<td>Nierenberg, Christopher</td>
<td>Sep 6, 1975</td>
<td>33</td>
</tr>
<tr>
<td>Miller, Joenna</td>
<td>Mar 19, 1975</td>
<td>35</td>
</tr>
<tr>
<td>Murrell, Ervin</td>
<td>Oct 5, 1978</td>
<td>31</td>
</tr>
<tr>
<td>Lnardakis, Jean-Pierre</td>
<td>Mar 15, 1976</td>
<td>34</td>
</tr>
<tr>
<td>Diamondstone, Cornelius</td>
<td>May 10, 1971</td>
<td>38</td>
</tr>
<tr>
<td>Hollos, Kini Kazu</td>
<td>Jan 10, 1977</td>
<td>33</td>
</tr>
<tr>
<td>Bonteloe, Randolph</td>
<td>May 2, 1976</td>
<td>34</td>
</tr>
<tr>
<td>Lao, Katsutoshi</td>
<td>Mar 28, 1973</td>
<td>37</td>
</tr>
<tr>
<td>Margitza, Alan C.</td>
<td>Jul 9, 1971</td>
<td>38</td>
</tr>
<tr>
<td>Kim, Jye Yong</td>
<td>Mar 13, 1972</td>
<td>33</td>
</tr>
<tr>
<td>Meyers, Shuqiao</td>
<td>May 9, 1978</td>
<td>31</td>
</tr>
<tr>
<td>Wei, William</td>
<td>Dec 16, 1977</td>
<td>32</td>
</tr>
<tr>
<td>Smiley, Kenneth R.</td>
<td>Feb 1, 1977</td>
<td>33</td>
</tr>
<tr>
<td>Hannum, Carl G.</td>
<td>Jun 3, 1977</td>
<td>32</td>
</tr>
<tr>
<td>Lyons, Paul</td>
<td>Jun 20, 1974</td>
<td>35</td>
</tr>
<tr>
<td>Galinbert, Olga T.</td>
<td>Jan 14, 1975</td>
<td>35</td>
</tr>
</tbody>
</table>

May 4, 2010


13. Click Save.
Understanding Aggregation

What is aggregation?

Aggregation is the summarization of grouped items. By default, Report Studio automatically groups non-numeric (text or date) data and summarizes numeric data. This means that the numbers you see in your reports are probably a summarization of the raw data from the database.

The User can turn off the Automatic aggregation. (Mouse over Query Explorer, click on a Query, under the Properties Section, set Auto Group and Summarize to “No”. A detailed exercise is explained in the ReportNet Level II course.)

Types of aggregation:
Some of the common types of aggregation are:

Total Sums the items in the group
Average Averages the items in the group
Minimum Shows the smallest number in the group
Maximum Shows the largest number in the group
Count Counts the number of items in the group

The default type of aggregation for each numeric data item is set in the package.
Adding Summary Totals to a Footer (Totaling a Column)

You can also create additional aggregates within the report. You can group a report and add summaries to the group footers.

An ungrouped report will show counts, totals, etc. for the entire report. However, if the report is grouped, and then counts, totals, etc. are added, the report will show the summaries for each individual group and for the report as a whole.

GOAL: To total ID’s for the entire report

STEPS:
1. Create a new list report with Country Description, Primary University Affiliation Description, and ID as columns.
2. Save the report as Count ID.
3. Highlight the ID List Column Body.
4. In the Properties section, set the Aggregate Function to “Count”.

Double click to edit text
5. Run the report. Notice there IDs are counted for each Primary University Affiliation Description and Country Description.

<table>
<thead>
<tr>
<th>Country Description</th>
<th>Primary University Affiliation Description</th>
<th>ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Germany</td>
<td>Employee</td>
<td>1</td>
</tr>
<tr>
<td>Austria</td>
<td>Student</td>
<td>1</td>
</tr>
<tr>
<td>United States</td>
<td>Miscellaneous</td>
<td>271</td>
</tr>
<tr>
<td>United States</td>
<td>Employee</td>
<td>230</td>
</tr>
<tr>
<td>Israel</td>
<td>Employee</td>
<td>1</td>
</tr>
</tbody>
</table>

6. Click the ID List Column Header.

7. Click the drop down arrow to the right of the Agggregate icon

8. In the drop down list, choose Count.

9. <ID> in bold is added at the bottom of the column, indicating a summary.

10. Run the report.

11. Click the Bottom link to go to the bottom of the report to view the footer.
12. The number of ID’s for the entire report is shown in the last row in bold. Close the Report Viewer.

<table>
<thead>
<tr>
<th>Country Description</th>
<th>Primary University Affiliation Description</th>
<th>ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Malaysia</td>
<td>Miscellaneous</td>
<td>1</td>
</tr>
<tr>
<td>Mauritius</td>
<td>Student</td>
<td>1</td>
</tr>
<tr>
<td>Mexico</td>
<td>Student</td>
<td>1</td>
</tr>
<tr>
<td>Morocco</td>
<td>Miscellaneous</td>
<td>1</td>
</tr>
<tr>
<td>New Zealand</td>
<td>Miscellaneous</td>
<td>1</td>
</tr>
<tr>
<td>Panama</td>
<td>Miscellaneous</td>
<td>1</td>
</tr>
<tr>
<td>Romania</td>
<td>Student</td>
<td>1</td>
</tr>
<tr>
<td>Singapore</td>
<td>Student</td>
<td>2</td>
</tr>
<tr>
<td>Taiwan</td>
<td>Student</td>
<td>1</td>
</tr>
<tr>
<td>Trinidad and Tobago</td>
<td>Employee</td>
<td>1</td>
</tr>
<tr>
<td>Turkey</td>
<td>Student</td>
<td>2</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>Employee</td>
<td>1</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>Miscellaneous</td>
<td>2</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>Student</td>
<td>3</td>
</tr>
<tr>
<td>United States</td>
<td>Employee</td>
<td>230</td>
</tr>
<tr>
<td>United States</td>
<td>Miscellaneous</td>
<td>271</td>
</tr>
<tr>
<td>United States</td>
<td>Student</td>
<td>473</td>
</tr>
<tr>
<td>Yugoslavia</td>
<td>Miscellaneous</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Employee</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>Miscellaneous</td>
<td>2</td>
</tr>
</tbody>
</table>

**Summary** 1059

13. Save the report as **Count ID List**.
Remove the Summary Footer

1. Click in the **Summary footer** at the bottom of the report. The footer is selected.

2. Press the **Delete** key.

3. The Summary footer and the ID count are deleted from the report.

4. **Save** the report.
Grouped Summary Footers

GOAL: To count per individual group.

STEPS:

1. Use the Count ID List report.
2. Group the report by Country Description and Primary University Affiliation Description.
3. Highlight the ID List Column Body.
4. In the Properties section, set the Aggregate Function to “Count”.
5. Click the ID List Column Header.
6. Click the drop down arrow to the right of the Aggregate icon.

7. In the drop down list, choose Calculated.

8. <ID> in bold is added at the bottom of the column, indicating a summary. Because the report is grouped by Country Description, and Primary University Affiliation Description, a summary footer is added for each grouping. The last footer (labeled <Summary>) will show a summary for the entire report, in this case, the Total of IDs for each group.

9. Run the report.
10. Click the **Bottom** link.
11. The report shows the number of people for each country, for each affiliation, and for the entire report.

<table>
<thead>
<tr>
<th>Country</th>
<th>Employee</th>
<th>Miscellaneous</th>
<th>Student</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turkey</td>
<td></td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>United Kingdom</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>United States</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Yugoslavia</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

May 4, 2010

12. **Close** the Report Viewer and **Save** the report as **Group Count ID**.
Summary Calculation Without Detail And Find the Average

You may wish to show aggregate data without showing the detail. To do this, we will create a column that shows only the count of ID’s, without showing the actual ID numbers.

**GOAL:** To create a basic summary calculated column.

**STEPS:**

1. **Open** the original Count ID report, without footers.

2. **Save** the report as Average ID Summary.

<table>
<thead>
<tr>
<th>Country Description</th>
<th>Primary University Affiliation Description</th>
<th>ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Country Description&gt;</td>
<td>&lt;Primary University Affiliation Description&gt;</td>
<td>&lt;ID&gt;</td>
</tr>
<tr>
<td>&lt;Country Description&gt;</td>
<td>&lt;Primary University Affiliation Description&gt;</td>
<td>&lt;ID&gt;</td>
</tr>
<tr>
<td>&lt;Country Description&gt;</td>
<td>&lt;Primary University Affiliation Description&gt;</td>
<td>&lt;ID&gt;</td>
</tr>
</tbody>
</table>

3. **Group** the Country Description and Primary University Affiliation Description columns.

4. **Click** on the ID List Body Column. In the Properties window, scroll down to Data Item.

5. **Click** the Aggregate Function area and then click the down arrow.

6. **Choose** Count.

---

Report Studio Introduction
7. Highlight the ID column heading.

8. In the Properties window, locate the Source Type field. Click on Source Type and then click on the drop-down button.

9. Select Text.

10. Inside the Text window, type the new column name “Count ID”.

11. Again, in the Properties window, locate the Text field. Click on Text and then click on the ellipse.

12. Type in “Count of IDs”

13. Click OK.
14. **Run** the report. (Instead of showing each individual ID, Report Studio summarizes by counting the number of ID’s associated with each Country and Affiliation.)

### Princeton University Information Warehouse

<table>
<thead>
<tr>
<th>Country Description</th>
<th>Primary University Affiliation Description</th>
<th>Count of IDs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Australia</td>
<td>Miscellaneous</td>
<td>1</td>
</tr>
<tr>
<td>Austria</td>
<td>Student</td>
<td>1</td>
</tr>
<tr>
<td>Belgium</td>
<td>Miscellaneous</td>
<td>1</td>
</tr>
<tr>
<td>Belgium</td>
<td>Miscellaneous</td>
<td>1</td>
</tr>
<tr>
<td>Belgium</td>
<td>Employee</td>
<td>5</td>
</tr>
<tr>
<td>Belgium</td>
<td>Miscellaneous</td>
<td>13</td>
</tr>
<tr>
<td>Belgium</td>
<td>Student</td>
<td>9</td>
</tr>
<tr>
<td>Costa Rica</td>
<td>Employee</td>
<td>1</td>
</tr>
<tr>
<td>Germany</td>
<td>Employee</td>
<td>1</td>
</tr>
<tr>
<td>Germany</td>
<td>Miscellaneous</td>
<td>1</td>
</tr>
<tr>
<td>Hong Kong</td>
<td>Employee</td>
<td>1</td>
</tr>
<tr>
<td>Hong Kong</td>
<td>Miscellaneous</td>
<td>1</td>
</tr>
<tr>
<td>Hong Kong</td>
<td>Student</td>
<td>1</td>
</tr>
<tr>
<td>India</td>
<td>Miscellaneous</td>
<td>1</td>
</tr>
<tr>
<td>India</td>
<td>Employee</td>
<td>1</td>
</tr>
<tr>
<td>Israel</td>
<td>Employee</td>
<td>1</td>
</tr>
<tr>
<td>Israel</td>
<td>Miscellaneous</td>
<td>1</td>
</tr>
<tr>
<td>Jamaica</td>
<td>Miscellaneous</td>
<td>1</td>
</tr>
<tr>
<td>Japan</td>
<td>Miscellaneous</td>
<td>1</td>
</tr>
<tr>
<td>Korea, Republic of</td>
<td>Employee</td>
<td>2</td>
</tr>
<tr>
<td>Korea, Republic of</td>
<td>Student</td>
<td>2</td>
</tr>
</tbody>
</table>

15. **Close** Report Viewer.

16. Highlight the **ID** column heading.

17. Click the drop down arrow to the right of the **Aggregate** icon.

18. In the drop down list, choose **Average**.
19.  \(<ID>\) in bold is added at the bottom of the column, indicating a summary. Because the report is grouped by \textbf{Country Description}, and \textbf{Primary University Affiliation Description}, a summary footer is added for each grouping. The last footer (labeled \(<\text{Summary}>\)) will show a summary for the entire report, in this case, the \textbf{Average} of IDs for each group.

18. \textbf{Run} the report and now you will see the average of ID’s per country.

<table>
<thead>
<tr>
<th>Country Description</th>
<th>Primary University Affiliation Description</th>
<th>Count of IDs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Australia</td>
<td>Miscellaneous</td>
<td>1</td>
</tr>
<tr>
<td>Australia</td>
<td></td>
<td><strong>1</strong></td>
</tr>
<tr>
<td>Austria</td>
<td>Student</td>
<td>1</td>
</tr>
<tr>
<td>Austria</td>
<td></td>
<td><strong>1</strong></td>
</tr>
<tr>
<td>Belgium</td>
<td>Miscellaneous</td>
<td>1</td>
</tr>
<tr>
<td>Belgium</td>
<td></td>
<td><strong>1</strong></td>
</tr>
<tr>
<td>Bulgaria</td>
<td>Miscellaneous</td>
<td>1</td>
</tr>
<tr>
<td>Bulgaria</td>
<td></td>
<td><strong>1</strong></td>
</tr>
<tr>
<td>Canada</td>
<td>Employee</td>
<td>5</td>
</tr>
<tr>
<td>Canada</td>
<td>Miscellaneous</td>
<td><strong>18</strong></td>
</tr>
<tr>
<td>Canada</td>
<td>Student</td>
<td><strong>9</strong></td>
</tr>
<tr>
<td>Canada</td>
<td></td>
<td><strong>10.666666666667</strong></td>
</tr>
</tbody>
</table>


19. \textbf{Save} the report.
5. Filters

Concepts
Opening the Filters Dialog Window
The Filters Dialog Window
Detail Filter Expression
Filtering on a Single Item from the Source (Source tab)
Filtering on a Single Item from the Data Items Tab
Filtering on Multiple Items (Using “in”)
Filtering on a Date Range (Using “between”)
Filtering Text (Using “starts with”)
Filter Text (Using “contains”)
Filtering using “Like” and a Wildcard
Concepts

A filter reduces the amount of data in a report by the criteria you set. You can filter one or more item(s), by a precise match, or by a partial match.

Expressions:
A filter expression is always comprised of these pieces:
- The column name, which can be taken from the report
- An operator, such as =
- The data we are searching for

An example of a filter expression is:

\[
[\text{Report Net Training Data}].[\text{Personal Data}].[\text{Country Code}] = '\text{CAN}'
\]

The operator indicates what kind of match is made. Below is a table of common operators:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>Equal to. Must find a precise match.</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>Not equal to. Shows everything except the match.</td>
</tr>
<tr>
<td>In</td>
<td>Matches a list of items.</td>
</tr>
<tr>
<td>Not In</td>
<td>Shows everything except the matches.</td>
</tr>
<tr>
<td>Starts With</td>
<td>Retrieves everything that begins with the characters or phrase.</td>
</tr>
<tr>
<td>Contains</td>
<td>Retrieves everything that contains the matching characters or phrase.</td>
</tr>
<tr>
<td>Is Missing</td>
<td>Retrieves blanks.</td>
</tr>
</tbody>
</table>
Opening the Filters Dialog Window

**GOAL:** To open and examine the Filters dialog window.

**STEPS:**

1. **Start a New List Report.** From the Personal data folder add:
   - Last Name
   - First Name
   - Country Code
   - Street Address 1
   - City
   - State
   - Postal Code
   - Birthdate

   ![Table](image)

2. **Click the Filters icon** and the Filters Dialog Window opens.
The Filters Dialog Window

The Filters window consists of two tabs, **Detail Filters** and **Summary Filters**. Detail Filters apply to rows in the report. Summary Filters apply to grouped data, or aggregate data, in the report. Summary filters are also used to apply to an item not in the package, such as a calculated item.
The **Usage** area consists of three options:

- **Required** – The filter is required. In the case of a prompt, the report will not run until you have made a choice from the prompt.
- **Optional** – The filter is optional. In the case of a prompt, the report will run even if you do not choose anything from the prompt.
- **Disabled** – The filter is disabled. Disabling a filter allows the report to run without applying the filter. The filter is not removed; it is de-activated which may help in trouble-shooting the report.

The **Application** area consists of two options.

- **Before Aggregation** – To apply a filter before a summary is calculated, non-aggregated records are filtered.
- **After Aggregation** – To apply a filter after a summary is calculated aggregated rows are filtered.

**Note:** Aggregation is discussed in the calculations chapter. It is covered in greater detail in the Report Studio Level II training manual.

The following icons are available for the filter expression.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Add" /></td>
<td>Used to add a filter.</td>
</tr>
<tr>
<td><img src="image" alt="Delete" /></td>
<td>Used to delete a filter.</td>
</tr>
<tr>
<td><img src="image" alt="Edit" /></td>
<td>Used to edit a filter.</td>
</tr>
</tbody>
</table>
Detail Filter Expression

From the Filters window, click the Add icon to open the Detail Filter Expression window.

**Source tab**

The Source tab allows you to filter on any item in the package. The Data Items tab allows you to filter on items in the report. The Query Items tab allows you to filter on items from other queries in your report. The Functions tab allows you to create filter calculations. The Parameters tab allows you to use the input derived from users when they answer the parameter.
Data Items tab

The **Data Items** tab allows you to filter on items in the report.
Query Items tab

The **Query Items** tab allows you to filter on items from other queries in your report.

![Query Items window with Query2 and its items listed: ID and Citizenship Status]
Functions tab

The **Functions** tab allows you to create filter calculations.

When building a filter, you can specify the data type. (This is optional; if you know the data you are looking for, you can type it directly into the expression, provided you use the correct syntax.)

Use the Constants folder to locate a list of available data types.
<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>date</td>
<td>Inserts the current system date.</td>
</tr>
<tr>
<td>date-time</td>
<td>Inserts the current system date and time.</td>
</tr>
<tr>
<td>interval</td>
<td>Inserts a zero interval.</td>
</tr>
<tr>
<td>null</td>
<td>Inserts a null value if the expression conditions are not met.</td>
</tr>
<tr>
<td>number</td>
<td>Inserts the number 0, which you can replace with a new numeric value.</td>
</tr>
<tr>
<td>string</td>
<td>Inserts an empty string.</td>
</tr>
<tr>
<td>time</td>
<td>Inserts the current system time.</td>
</tr>
</tbody>
</table>
Parameters tab

The **Parameters** tab allows you to use the input derived from users when they answer the parameter.
Filtering on a Single Item from the Source (Source tab)

Report Studio provides the flexibility to either filter on an item in the model, or on an item in the report. The Source tab is the location to use to filter on an item in the model.

**GOAL:** To create a filter (Detail) on Employee.

**STEPS:**

1. Cancel out of the **Detail Filter Expression** window and the **Filters Dialog** window and Save the report as **Pre Filter**.

2. **Run** the report to see the report before any filters are applied.

3. Close the **Report Viewer**.
4. On the toolbar, click the Filters icon \( \text{Filters} \) and the Filters window opens.

5. Click the Add icon \( \text{Add} \).

6. From the Source tab, double-click Primary University Affiliation Description.

7. Click the Functions tab.
8. Open the Operators folder and double-click the equal sign “=”. 

**Note:** You can also type the equal sign if preferred.

9. Click the Source tab and make sure Primary University Affiliation Description is highlighted.

10. Click the Select Value icon.
11. Highlight Employee.

12. Click Insert.

**Note:** Spacing within the Expression does not matter. Only spacing between single quotes ‘ ‘ matters as whatever is between the single quotes is the exact string on which Cognos will search the records in the Database.

13. In the Detail Filter Expression window, click the Validate icon. The Report Studio window will show the validation process with the server.
14. When the validation process is complete and successful, you will see a “No errors” message in the **Errors** window.

15. Click **OK**.
16. The new filter appears in the Filters window in the Details Filters tab.

17. Click OK.
18. Run the report.

20. From the **Personal Data** folder, add **Primary University Affiliation Description** as the last column.

<table>
<thead>
<tr>
<th>Last Name</th>
<th>First Name</th>
<th>Country Code</th>
<th>Street Address 1</th>
<th>City</th>
<th>State</th>
<th>Postal Code</th>
<th>Birthdate</th>
<th>Primary University Affiliation Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Last Name&gt;</td>
<td>&lt;First Name&gt;</td>
<td>&lt;Country Code&gt;</td>
<td>&lt;Street Address 1&gt;</td>
<td>&lt;City&gt;</td>
<td>&lt;State&gt;</td>
<td>&lt;Postal Code&gt;</td>
<td>&lt;Birthdate&gt;</td>
<td>&lt;Primary University Affiliation Description&gt;</td>
</tr>
<tr>
<td>&lt;Last Name&gt;</td>
<td>&lt;First Name&gt;</td>
<td>&lt;Country Code&gt;</td>
<td>&lt;Street Address 1&gt;</td>
<td>&lt;City&gt;</td>
<td>&lt;State&gt;</td>
<td>&lt;Postal Code&gt;</td>
<td>&lt;Birthdate&gt;</td>
<td>&lt;Primary University Affiliation Description&gt;</td>
</tr>
<tr>
<td>&lt;Last Name&gt;</td>
<td>&lt;First Name&gt;</td>
<td>&lt;Country Code&gt;</td>
<td>&lt;Street Address 1&gt;</td>
<td>&lt;City&gt;</td>
<td>&lt;State&gt;</td>
<td>&lt;Postal Code&gt;</td>
<td>&lt;Birthdate&gt;</td>
<td>&lt;Primary University Affiliation Description&gt;</td>
</tr>
</tbody>
</table>

21. **Run** the report.  (You will see the applied filter on Employee.)

<table>
<thead>
<tr>
<th>Last Name</th>
<th>First Name</th>
<th>Country Code</th>
<th>Street Address 1</th>
<th>City</th>
<th>State</th>
<th>Postal Code</th>
<th>Birthdate</th>
<th>Primary University Affiliation Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Barnes</td>
<td>Steve</td>
<td>USA</td>
<td>40 Fox Chase Rd</td>
<td>New York</td>
<td>NY</td>
<td>10072</td>
<td>2003</td>
<td>Apr 2, 1977</td>
</tr>
<tr>
<td>Fernandez</td>
<td>Sarah</td>
<td>USA</td>
<td>5 Witham Court</td>
<td>Princeton</td>
<td>NJ</td>
<td>08540</td>
<td>1975</td>
<td>Apr 14, 1975</td>
</tr>
<tr>
<td>Hackett</td>
<td>Roy</td>
<td>USA</td>
<td>24 Lamont Avenue</td>
<td>Yorba</td>
<td>NJ</td>
<td>08406</td>
<td>1975</td>
<td>Apr 23, 1975</td>
</tr>
<tr>
<td>Finkt</td>
<td>Willen</td>
<td>USA</td>
<td>30 Attlebury Rd</td>
<td>Timonsun</td>
<td>MD</td>
<td>21603</td>
<td>1974</td>
<td>Mar 22, 1974</td>
</tr>
<tr>
<td>Gobin</td>
<td>Giovanni</td>
<td>USA</td>
<td>166 Monroe Rd</td>
<td>Pottomac</td>
<td>MD</td>
<td>20834</td>
<td>1973</td>
<td>Aug 1, 1973</td>
</tr>
<tr>
<td>Downeystone</td>
<td>Cornelius</td>
<td>USA</td>
<td>215 North Main St</td>
<td>Washington</td>
<td>DC</td>
<td>20007</td>
<td>1971</td>
<td>May 10, 1971</td>
</tr>
<tr>
<td>Hawkins</td>
<td>Jang</td>
<td>CRI</td>
<td>129 Gary Drive</td>
<td>San Jose</td>
<td></td>
<td></td>
<td></td>
<td>Jun 3, 1978</td>
</tr>
<tr>
<td>Jordan</td>
<td>Hidestahbo</td>
<td>CRI</td>
<td>42 Pin Oak Rd</td>
<td>Andover</td>
<td>MA</td>
<td>01810</td>
<td>1978</td>
<td>Sep 30, 1978</td>
</tr>
<tr>
<td>Levy</td>
<td>Taihuya</td>
<td>USA</td>
<td>160 Lower Creek Rd</td>
<td>Falls Church</td>
<td>VA</td>
<td>22046</td>
<td>1975</td>
<td>Nov 29, 1975</td>
</tr>
<tr>
<td>Huang</td>
<td>Rachel</td>
<td>USA</td>
<td>24 Pollar Lane</td>
<td>Portland</td>
<td>OR</td>
<td>97225</td>
<td>1976</td>
<td>Mar 1, 1976</td>
</tr>
<tr>
<td>Robson</td>
<td>Conen</td>
<td>USA</td>
<td>One Dayon Lane</td>
<td>Yllano</td>
<td>PA</td>
<td>19935</td>
<td>1975</td>
<td>Sep 17, 1975</td>
</tr>
<tr>
<td>Ross</td>
<td>Johnnie</td>
<td>USA</td>
<td>974 B Road St</td>
<td>Cther</td>
<td>NJ</td>
<td>07950</td>
<td>1978</td>
<td>Jan 31, 1978</td>
</tr>
<tr>
<td>Stricklin</td>
<td>Nikolous</td>
<td>USA</td>
<td>202 Balon Court</td>
<td>Fayetteville</td>
<td>NY</td>
<td>13066</td>
<td>1977</td>
<td>Apr 18, 1977</td>
</tr>
<tr>
<td>Symondska</td>
<td>Christopher</td>
<td>USA</td>
<td>104 Pamela Court</td>
<td>Glenside</td>
<td>PA</td>
<td>19038</td>
<td>1982</td>
<td>Mar 1, 1982</td>
</tr>
<tr>
<td>Stahl</td>
<td>Kenneth</td>
<td>USA</td>
<td>163 Becksville Rd</td>
<td>Moorseville</td>
<td>NJ</td>
<td>08057</td>
<td>1975</td>
<td>Jan 9, 1975</td>
</tr>
<tr>
<td>Ferguson</td>
<td>Alan</td>
<td>USA</td>
<td>7 East Cloe</td>
<td>Alexandria</td>
<td>VA</td>
<td>22314</td>
<td>1975</td>
<td>Jun 22, 1975</td>
</tr>
</tbody>
</table>

22. **Close** the Report Viewer.

23. **Save** the report as **Employees**.
Filtering on a Single Item from the Data Items Tab

When creating reports that contain filters, it is common to show the column in the report that corresponds to the filtered subject. For instance, if you were filtering on Binoculars, generally you would show the Product type column to re-emphasize that the report is limited to just one product type.

**Note:** If a data item is deleted from the Query, any filter referencing that data item will no longer work; the report will not run.

**GOAL:** To create a filter (Detail) on Canada.

**STEPS:**

1. Open the **Pre Filter** report. Save the report as **Canada**.

2. Click the **Filters** icon on the Toolbar.

3. Click the **Add** icon

![Filtering on a Single Item from the Data Items Tab](image-url)
4. The Detail Filter Expression window opens.

5. Click the **Query Items** tab to display the data items used in the report query.

**Note:** If a field is chosen from the **Query Items** tab and is deleted from the Report, then the Expression will fail.
6. Double-click **Country Code**.

7. In the Expression Definition window, click the cursor at the end of the word Country Code and type an equal sign “=”.
8. Click the Select Value icon.

9. In the Select Value window, click CAN for Canada.

10. Click Insert.
11. In the Detail Filter Expression window, click the **Validate** icon. You should receive the “No errors” message.

12. Click **OK** and you will see the newly created filter.

13. Click **OK** to return to the report.
14. **Run the report.** When the report runs, you will only see the country of Canada.

15. **Close** the Report Viewer.

16. **Save** the report.
Usage (Required, Optional, Disabled)

As mentioned in the concepts section at the beginning of the chapter, after a filter is created, there are three choices available: Required, Optional, and Disabled.

The previous report defaulted to Required. In other words, the filter that was created (\([\text{Country Code}]={’CAN’}\)) is required or necessary. However, the filtering option can be changed to Optional, or Disabled.

**Required** means the filter definition has to be used.

Choosing **Optional** means the filter does not have to be used in order for the report to run. In the case of a prompt, the report will run even if you do not choose anything from the prompt.

Choosing **Disabled** allows the user to run the report as if there was no filter. Therefore, debugging or trouble-shooting is easy and convenient as the filter is temporarily “turned off”.

**GOAL:** To disable the Country equals Canada filter.

**STEPS:**

1. Use the **Canada** report.

2. Click the **Filters** icon.

3. Make sure the **Detail Filters** tab is selected.
4. **Highlight** the Canada filter. Under Usage, click **Disabled**.

5. Click **OK**.

6. **Run** the report and notice that all countries are showing.

7. **Close** the Report Viewer.

8. Change the filter back to **Required**.
EXERCISE

- Use the Canada report.
- Save the report as Gender.
- Add Gender Description as a column
- In the Filter window, remove the Country filter.
- Create a filter on Gender Description = ‘Female’
- Save the report.
Filtering on Multiple Items (Using “in”)

When using the equal sign “=”, the expression can only equal one item. However, if you want to create a filter that can look for multiple items, it is most effective to use an “in” statement that allows you to filter on multiple items.

**GOAL:** To filter on several countries.

**Linear Process:** Retrieve only people who live in either Canada or Hong Kong

**STEPS:**

1. Open the Canada report.
2. Save the report as Multiple Countries.
3. Click the Filter icon.
4. From the Detail Filters tab click on the [Country]=’Canada’ filter. Make sure the Usage is set to Required.
5. Click the Edit icon.
6. Place your cursor at the end of the current filter statement and delete =’CAN’.
7. After Country Code, type in.
8. On the left, under Personal Data, click **Country Code** once and then click the **Select Multiple Values** icon.

9. A message box appears because a data item must be selected.

10. Click OK.

11. From the **Source** tab, under Personal Data, click once on the **Country Code** data field.

12. Click the **Select Multiple Values** icon.
13. On the left side, highlight HKG and click the Add icon to add Hong Kong to the right side.

14. On the left side, double-click JPN to add Japan to the right side.
15. Click **Insert** and view the new filter definition.

16. Click **Validate**.

17. Click **OK** to view the filter in the Filters window, and **OK** again to return to the Report Page.

18. **Run** the report. (Notice that only Hong Kong and Japan appear in the Country column.)
19. **Close** the Report Viewer.

20. Click **Save**.

**EXERCISE**

Using the current report:

- Change the filtered countries to two of your choice.

**Tip:** You can type the values directly into the Expression Definition.
Filtering on a Date Range (Using “between”)

The “between” expression allows the user to look for anything that happened within a range of dates, such as a beginning and an ending date.

GOAL: To filter on a range of dates.

STEPS:

1. Open the Pre-Filter report and save it as Filter by Dates.
2. Click the Filter icon.
3. Click the Add icon.
4. From the Source tab, double-click Birthdate.
5. Click the cursor at the end of the Expression Definition and type a space.
6. Type the following: **between 1978-09-16 and 1980-12-31**.

![Expression Definition:](image)

**Note:** When using date-type fields in an Expression, like the **Birthdate** field, single quotes are not needed. Single quotes are needed for character-type fields, like **Name**.

7. Click **Validate** to make sure there are no errors.

8. Click **OK**.

9. Click **OK** to close the Filters window.
10. **Run the report.**

11. **Close the Report Viewer.**

12. **Save** the report.

**Note:** Although the word “between” is used, it actually includes the beginning and end date that is in the expression. September 16, 1978 and December 31, 1980 are included in the filter.
Filtering Text (Using “starts with”)

The “starts with” and “contains” operators are very useful if you are not sure how to spell the entire name or if you know only a portion of the name.

To filter using starts with:

**GOAL:** To find all the last names that starts with ‘am’.

**STEPS:**

1. Open the Pre Filter report and save it as Filter Starts With.
2. Click the Filters icon.
3. In the Filters window, click the Add icon.
4. From the Source tab, double-click Last name.
5. Click the cursor in the Expression Definition after [Last name].
6. Click the **Functions** tab and expand the **Operators** folder.

7. Double-click **starts with**.

8. Notice under the **Information** heading it shows how the **Starts With** expression syntax should be written: “string1 STARTS WIFI string2”

**Note:** Instead of double-clicking on the operator “Starts With”, it can be typed directly into the Expression.

9. Click the cursor in the **Expression Definition** after **starts with**.

10. Open the **Constants** folder.
11. Double-click **string** to add a set of single quotes after “starts with”.

**Note:** Last name is a text field; therefore, you must use the single quotes around the text.

12. Click the cursor between the **single quotes**.
13. Type `am`. Whatever appears in the string, in this case, `am`, must exactly match the record stored in the database table.

14. Click the **Validate** icon.

15. If there are no errors, click **OK** to see the newly created filter.

16. Click **OK**.
17. **Run** the report to see all the people whose last name starts with ‘am’. The report returns no data because the first letter of the Last Name is in upper case. We must change the filter so that names beginning with “Am” are found. Again, whatever appears in the string, in this case, **am**, must exactly match the record stored in the database table.

![Image of report viewer](image1)

18. **Close** the report viewer.

19. Click the **Filters** icon.

20. Make sure the filter is highlighted and then click **Edit**.

![Image of filters section](image2)

21. Click the cursor in front of **[Report Net Training Data].[Personal Data].[Last Name]**.

22. Click the **Functions** tab and open the **Common Functions** folder.

23. Scroll down and double click on **lower**.
Note: Spacing in the Expression does not matter. Notice how the function “lower” is on a different line than the rest of the expression. Again, Spacing in an Expression does not matter.

24. Click the cursor after Last Name] and type a ).

25. Click the Validate icon and confirm there are no errors.

26. Click OK and view the new filter.

27. Click OK again.

28. Run the report. The report now shows last names beginning with ‘Am.’

29. Click Save.
Filter Text (Using “contains”)  

**GOAL:** To filter the report to find all the last names which contain “am”.

**STEPS:**

1. Using the current report, **Save As:** Filter with Contains.

2. Click the **Filters** icon.

3. In the Filters window, make sure the current filter is highlighted and click the **Edit** icon.

4. Delete the last part of the current filter, “starts with ‘am’”.

5. From the **Functions** tab, open the **Operators** folder, and double-click **contains**.

6. Open the **Constants** folder and double-click **string**.

7. Click the cursor between the single quote marks and type **am**.

8. Click the **Validate** icon and make sure there are no errors.

9. Click **OK**.

10. Click **OK**.
11. **Run** the report to see all the last names that contain ‘am’.

**Note:** Last names that start with ‘Am’ as well as last names containing ‘am’ are included.

<table>
<thead>
<tr>
<th>Last Name</th>
<th>First Name</th>
<th>Country Code</th>
<th>Street Address 1</th>
<th>City</th>
<th>State</th>
<th>Postal Code</th>
<th>Birthdate</th>
<th>Primary University Affiliation Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Davidson</td>
<td>Cornelius</td>
<td>USA</td>
<td>215 North Main Street</td>
<td>Washington</td>
<td>DC</td>
<td>20007</td>
<td>May 10, 1971</td>
<td>Employee</td>
</tr>
<tr>
<td>Chen</td>
<td>Chuan-Hsiung</td>
<td>USA</td>
<td>132 Griggs Drive</td>
<td>Abilene</td>
<td>TX</td>
<td>7920</td>
<td>Jun 3, 1977</td>
<td>Employee</td>
</tr>
<tr>
<td>Arif</td>
<td>Masako</td>
<td>CAN</td>
<td>304 Evanson Dr. 2a</td>
<td>Ottawa</td>
<td>ON</td>
<td>K1S1M9</td>
<td>Oct 21, 1979</td>
<td>Student</td>
</tr>
<tr>
<td>Graham</td>
<td>Rini</td>
<td>USA</td>
<td>40 Zegers Lane</td>
<td>Florissant</td>
<td>MO</td>
<td>63031</td>
<td>May 29, 1976</td>
<td>Student</td>
</tr>
<tr>
<td>McConley</td>
<td>Julian</td>
<td>USA</td>
<td>3 Redbrook Lane</td>
<td>New York</td>
<td>NY</td>
<td>10128</td>
<td>Mar 13, 1978</td>
<td>Student</td>
</tr>
<tr>
<td>Strom</td>
<td>Robert</td>
<td>CAN</td>
<td>937 W Trenton Avenue</td>
<td>Toronto</td>
<td>ON</td>
<td>M9R1Z2</td>
<td>Jan 12, 1977</td>
<td>Student</td>
</tr>
<tr>
<td>Strampje</td>
<td>Muhammad</td>
<td>USA</td>
<td>26 Salie Street</td>
<td>New York</td>
<td>NY</td>
<td>10011</td>
<td>Jan 26, 1978</td>
<td>Student</td>
</tr>
<tr>
<td>Cunningham</td>
<td>Anthony</td>
<td>DEU</td>
<td>300 Applebee Drive</td>
<td>Dusseldorf</td>
<td>DE</td>
<td>40237</td>
<td>Dec 22, 1979</td>
<td>Student</td>
</tr>
<tr>
<td>Amor</td>
<td>Ze-Kie</td>
<td>USA</td>
<td>36 Junior Row</td>
<td>Flower Mound</td>
<td>TX</td>
<td>73022</td>
<td>Dec 31, 1980</td>
<td>Student</td>
</tr>
<tr>
<td>Amor</td>
<td>Maria</td>
<td>USA</td>
<td>116 Niagara Lane</td>
<td>Bloomfield Hills</td>
<td>MI</td>
<td>48301</td>
<td>Jan 30, 1975</td>
<td>Student</td>
</tr>
<tr>
<td>Kramer</td>
<td>Katherine</td>
<td>USA</td>
<td>280 Probert Avenue</td>
<td>Chicago</td>
<td>IL</td>
<td>60614</td>
<td>Nov 4, 1944</td>
<td>Student</td>
</tr>
<tr>
<td>Ramirez</td>
<td>Gibran</td>
<td>USA</td>
<td>5 Winnipeg Lane</td>
<td>Fort Worth</td>
<td>TX</td>
<td>76132</td>
<td>Nov 20, 1979</td>
<td>Student</td>
</tr>
<tr>
<td>Waleham</td>
<td>Karin</td>
<td>USA</td>
<td>26 Mikey Mount Lane</td>
<td>Fayetteville</td>
<td>NC</td>
<td>28511</td>
<td>Mar 16, 1978</td>
<td>Student</td>
</tr>
<tr>
<td>Lambert</td>
<td>Natalia</td>
<td>USA</td>
<td>106 Coburn Road</td>
<td>Lutherville</td>
<td>MD</td>
<td>21093</td>
<td>Jul 13, 1978</td>
<td>Student</td>
</tr>
<tr>
<td>Pembrough</td>
<td>Richard</td>
<td>USA</td>
<td>Po Box 604</td>
<td>Westbury</td>
<td>NY</td>
<td>11580</td>
<td>May 18, 1977</td>
<td>Employee</td>
</tr>
<tr>
<td>Lewis</td>
<td>Peter</td>
<td>USA</td>
<td>6 Prince Way</td>
<td>Peekskill</td>
<td>NY</td>
<td>10556</td>
<td>Nov 12, 1969</td>
<td>Employee</td>
</tr>
<tr>
<td>Schrama</td>
<td>Stephen</td>
<td>USA</td>
<td>230 Reeves Avenue</td>
<td>Rochester</td>
<td>NY</td>
<td>14606</td>
<td>Nov 21, 1972</td>
<td>Student</td>
</tr>
<tr>
<td>Amor</td>
<td>Shenon</td>
<td>USA</td>
<td>9 Saylor Court</td>
<td>Woodside</td>
<td>CA</td>
<td>94062</td>
<td>Jul 30, 1979</td>
<td>Student</td>
</tr>
<tr>
<td>Konata</td>
<td>Teresa</td>
<td>USA</td>
<td>330 Rookmamurian Road</td>
<td>Brooklyn</td>
<td>NY</td>
<td>11201</td>
<td>Jan 10, 1980</td>
<td>Student</td>
</tr>
<tr>
<td>Sims</td>
<td>Tawesha</td>
<td>USA</td>
<td>Apartment 2B</td>
<td>Venice</td>
<td>FL</td>
<td>34293</td>
<td>Oct 10, 1978</td>
<td>Student</td>
</tr>
</tbody>
</table>

12. **Close** the report viewer.

13. **Click Save**.
Filtering using “Like” and a Wildcard

When trying to retrieve records that match a certain pattern, use the “Like” operator. You can use “Like” in two different formats:

With a Wildcard %
- Using the percentage sign % allows you to match any string, of any length, including strings with zero length.

With an Underscore _
- Using an underscore _ allows you to match on a single character

GOAL: To filter Postal Code records which begin with ‘K’

Linear Process: Retrieve only people who live in Postal Codes which begin with ‘K’

STEPS:
1. Using the previous report, click on the Filter icon.
2. Save the report as Multiple Countries.
3. Click the Filter icon.
4. From the Detail Filters tab click once on the [Last Name] Contains 'am' filter. Set the Usage to Disabled.
5. Click on the Add icon.
6. In the Expressions window, add the Postal Code field from the Source tab.
7. From the **Functions** tab, open the **Operators** folder, and add the “Like” operator, after the **Postal Code** field. Add K% after the **Like** operator, in single quotes

The Expression should read:  

![Image of the filter expression with the Like operator and K% added]

**Note:** Starting the string with a capital letter K, followed by the wildcard, percentage sign, requires that all **Postal Records** records returned will begin with a capital letter K. The wildcard after the capital letter K indicates that any character, or number, can follow the capital letter K.

8. Click **OK** and **OK**.

9. Run the Report. Notice that all records returned begin with a capital letter K in the **Postal Code** column, followed by either characters or numbers.

11. From within Report Studio, click again on the Filters icon.


13. In the Expressions window, add a wildcard value, %, before the capital letter K. The Expression should read:  
   \text{[Report Net Training Data].[Personal Data].[Postal Code] like } \%K\%

14. Click OK and OK.

15. Run the report. Notice that more records appear. Editing the Filter to contain a wildcard \textit{before} the capital letter K returns \textbf{Postal Code} records which do not begin with a capital K, but contains a capital K somewhere in the record.

EXERCISE  (This exercise is needed for the Prompt section that follows.)

Create a new report with the following columns:
- ID
- Full Name
- Primary University Affiliation Description
- Primary University Affiliation Group Description
- Gender Description
- Save the report as: \textbf{Pre Prompt}.  

<table>
<thead>
<tr>
<th>Last Name</th>
<th>First Name</th>
<th>Country Code</th>
<th>Street Address 1</th>
<th>City</th>
<th>State</th>
<th>Postal Code</th>
<th>Birthdate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ankdam</td>
<td>Masako</td>
<td>CAN</td>
<td>304 Emmons Dr. 2a</td>
<td>Ottawa</td>
<td>CN</td>
<td>K1S 1M9</td>
<td>Oct 21, 1979</td>
</tr>
<tr>
<td>Belk</td>
<td>Pingfang</td>
<td>CAN</td>
<td>44 Highland Drive</td>
<td>Ottawa</td>
<td>CN</td>
<td>K1T 4H6</td>
<td>Dec 31, 1974</td>
</tr>
<tr>
<td>Takazawa</td>
<td>Michiko</td>
<td>GBR</td>
<td>6G Brookline Court</td>
<td>Oxshott</td>
<td>KT22OTP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Matsushima</td>
<td>Ken-Ichi</td>
<td>CAN</td>
<td>160 Patton Avenue</td>
<td>Stirling</td>
<td>CN</td>
<td>K0K3E0</td>
<td>Apr 4, 1978</td>
</tr>
<tr>
<td>Visotzky</td>
<td>Kari</td>
<td>CAN</td>
<td>26 Alexander Street</td>
<td>Calgary</td>
<td>AB</td>
<td>T2T6K7</td>
<td>Jul 22, 1980</td>
</tr>
<tr>
<td>Araneo</td>
<td>Eri</td>
<td>CAN</td>
<td>125 Hollow Oak Court</td>
<td>SaltSpring Island</td>
<td>BC</td>
<td>V8K135</td>
<td>Jan 29, 1981</td>
</tr>
</tbody>
</table>
6. Prompts

Parameters and Prompts

Building a Parameter Filter

Prompt Pages with Prompts

Use a Parameter in Formatting

Identify the Query and Parameter Filter

Prompts – Selecting Multiple Items in the Same Prompt

Prompt Button
Parameters and Prompts

When you create a filter in the filter window, your filter criteria remains static. Prompts allow the user to change their criteria each time they run the report. The filter dynamically changes when the user responds to the prompt.

A **parameter** is a placeholder that requires a value to determine what data on which to report. This placeholder is a **parameterized filter**. A **prompt** asks the user to provide the value for the parameter. Prompts can be placed on a **Prompt Page**.

Every **prompt** will have an associated **parameterized filter** in the query. Every prompt does **not** need to have a prompt page created.

We will explore three ways of creating parameters:
1. Modifying an existing filter to create a parameterized filter.
2. Creating a prompt page and then adding prompts on the page.

Modifying an existing filter to create a parameterized filter:
- If you create a parameter for an item on the report, when the report is run, the user will be prompted to specify a value. Once a value is entered, the report runs containing the information according to the given value in the prompt.

Creating a prompt page and adding prompts on the page.
- If you add a prompt page to your report, the prompt page appears when you run the report. The prompt page can contain multiple prompts, and the prompts can be for items that are not on the report. The properties of a prompt on a prompt page can be changed to optional.
- Prompt items can be added directly onto a report page. Drag the prompt object from the toolbox tab onto the report page next to a list, crosstab, or chart. When the report is run, the report appears with a prompt on the page, letting the user narrow the focus after viewing the initial report. (If you add a prompt directly onto a report page, the user will either need to set the prompt to automatically submit the selection, or add a “Finish” prompt button to the report so that the report will regenerate using the new criteria.)
Prompts are located in the Toolbox tab of the Insertable Objects window.

When the user selects items on a report and creates a prompt page, Report Studio will choose an appropriate prompt type. However, if the user adds a prompt item to a report or prompt page, the user can choose any type of prompt available in the Insertable Objects pane according to his needs.

The various prompt types and values are listed below.

<table>
<thead>
<tr>
<th>Prompt Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text Box Prompt</td>
<td>Retrieves data based on an exact value entered. Use this control when you know exactly what data item you want to enter, such as a name or project grant number.</td>
</tr>
<tr>
<td>Value Prompt</td>
<td>Retrieves data based on values that selected from a list. Use this control to show a list of possible values from which users can choose. <strong>Note:</strong> The maximum number of items that can appear in a list is 5000.</td>
</tr>
<tr>
<td>Select &amp; Search Prompt</td>
<td>Retrieves values based on specified search criteria. Data is then retrieved based on values you select from the search results. Use this control instead of a value prompt if the list of values is very long, which can slow down performance. Tip: You can perform a case sensitive or case insensitive search. A case sensitive search is faster, while a case insensitive search usually returns more values.</td>
</tr>
<tr>
<td>Date Prompt</td>
<td>Retrieves values based on a selected date. Use this control to filter a date column to retrieve records for a specific day, a set of days, or a range of days.</td>
</tr>
<tr>
<td>Time Prompt</td>
<td>Prompts based on a date and time you select. Use this control to restrict a report to a particular time or time range.</td>
</tr>
<tr>
<td><strong>Prompt</strong></td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Date &amp; Time Prompt</td>
<td>Retrieves values based on a selected date and time. Use this control to filter a date/time or timestamp column. This control is useful for specifying ranges.</td>
</tr>
<tr>
<td>Interval Prompt</td>
<td>Retrieves data based on a specified time interval. Use this control to retrieve data that is related to the passage of time.</td>
</tr>
<tr>
<td>Tree Prompt</td>
<td>Retrieves data based on values selected from a list. Values are organized hierarchically. <em>This prompt is used with dimensional data, which is not how the Princeton Information Warehouse is organized.</em> Data in the Princeton Information Warehouse is relational data.</td>
</tr>
<tr>
<td>Generated Prompt</td>
<td>Report Studio dynamically selects a prompt control based on the data type of the data item. This control acts like a placeholder. When users run the report, the control is replaced by the appropriate prompt control. For example, if users are prompted for date values, the control is replaced by a date &amp; time prompt.</td>
</tr>
</tbody>
</table>
Building a Parameter Filter

GOAL: To build a prompt within the Pre-prompt report.

Linear Process: When the report is run, allow the Report Viewer to choose which Gender records (Male, Female, Unknown) are returned.

STEPS:

1. Use the Gender report. Save the report as Gender Parameter.


3. Close the report viewer.

4. On the toolbar, click the Filters icon and the Filters window opens.
5. Select the current filter and click the edit icon.

![Image of Filter Editor]

6. In the expression window, remove the single quotes on each side of the word Female and replace with question marks.

**Note:** Placing question marks after the = changes the filter into a parameter filter.

![Image of Expression Editor]

7. Click Validate.
8. Because the filter is now a parameter filter, validating the expression will open a prompt window.

<table>
<thead>
<tr>
<th>Prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provide values for the report you are about to run.</td>
</tr>
<tr>
<td>* Indicates a required field.</td>
</tr>
<tr>
<td>‣ Points to missing information.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Gender Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Provide a value:</strong></td>
</tr>
<tr>
<td>* Gender Description</td>
</tr>
<tr>
<td>Gender Description</td>
</tr>
<tr>
<td>-------------------</td>
</tr>
<tr>
<td>Female</td>
</tr>
<tr>
<td>Unknown</td>
</tr>
</tbody>
</table>

9. Select any value and click **OK**.
10. The Information Window will report **No errors**.

11. Click **OK** to return to the Filters window.

12. Click **OK**.

13. Run the report.
14. In the prompt window, there is a drop-down prompt. Click the drop-down arrow in the prompt window. All values for **Gender Description** will display; *Male, Female, Unknown*.

15. Select “Male”.

16. Click **OK**.
17. Only rows containing “Male” in the Gender Description column will be returned in the report.

<table>
<thead>
<tr>
<th>ID</th>
<th>Full Name</th>
<th>Primary University Affiliation Description</th>
<th>Primary University Affiliation Group Description</th>
<th>Gender Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>000000001</td>
<td>Xu, Tinkaf</td>
<td>Employee</td>
<td>Human Resources</td>
<td>Male</td>
</tr>
<tr>
<td>000000008</td>
<td>Michel, Steven</td>
<td>Employee</td>
<td>Human Resources</td>
<td>Male</td>
</tr>
<tr>
<td>000000187</td>
<td>Levy, Milton</td>
<td>Employee</td>
<td>Human Resources</td>
<td>Male</td>
</tr>
<tr>
<td>000000243</td>
<td>Terry, Arthur Barry</td>
<td>Employee</td>
<td>Human Resources</td>
<td>Male</td>
</tr>
<tr>
<td>000000349</td>
<td>Dickerson, Feng</td>
<td>Student</td>
<td>Graduate</td>
<td>Male</td>
</tr>
<tr>
<td>000000458</td>
<td>Potwitz, Roger A.</td>
<td>Student</td>
<td>Graduate</td>
<td>Male</td>
</tr>
<tr>
<td>000000570</td>
<td>Halter, Scott</td>
<td>Student</td>
<td>Undergraduate</td>
<td>Male</td>
</tr>
<tr>
<td>000001024</td>
<td>Sato, Tony</td>
<td>Miscellaneous</td>
<td>Friend</td>
<td>Male</td>
</tr>
<tr>
<td>000001051</td>
<td>Rockman, Edward O</td>
<td>Miscellaneous</td>
<td>Friend</td>
<td>Male</td>
</tr>
<tr>
<td>000000099</td>
<td>Sherman, Mike</td>
<td>Employee</td>
<td>Human Resources</td>
<td>Male</td>
</tr>
<tr>
<td>000000040</td>
<td>Frakt, William T.</td>
<td>Employee</td>
<td>Human Resources</td>
<td>Male</td>
</tr>
<tr>
<td>000000045</td>
<td>Murrell, Darvin</td>
<td>Employee</td>
<td>Human Resources</td>
<td>Male</td>
</tr>
<tr>
<td>000000151</td>
<td>Chase, Daniel</td>
<td>Employee</td>
<td>Human Resources</td>
<td>Male</td>
</tr>
<tr>
<td>000000048</td>
<td>Vallee, Robert P.</td>
<td>Employee</td>
<td>Human Resources</td>
<td>Male</td>
</tr>
<tr>
<td>000000025</td>
<td>Carbine, Bruce E.</td>
<td>Employee</td>
<td>Human Resources</td>
<td>Male</td>
</tr>
<tr>
<td>000000191</td>
<td>Kaufman, Alan Cooker</td>
<td>Miscellaneous</td>
<td>Departmental Computer User</td>
<td>Male</td>
</tr>
<tr>
<td>000001042</td>
<td>Nassey, Ronald</td>
<td>Miscellaneous</td>
<td>Friend</td>
<td>Male</td>
</tr>
<tr>
<td>000001033</td>
<td>Truly, Judith V.</td>
<td>Miscellaneous</td>
<td>Friend</td>
<td>Male</td>
</tr>
<tr>
<td>000001036</td>
<td>Edelstyn, Jettie</td>
<td>Miscellaneous</td>
<td>Friend</td>
<td>Male</td>
</tr>
<tr>
<td>000000149</td>
<td>Cho, K. Wils</td>
<td>Employee</td>
<td>Human Resources</td>
<td>Male</td>
</tr>
</tbody>
</table>

18. Close the report window.

19. Save the report.

20. On the toolbar, click the Filters icon .

21. Open the Gender Description parameter filter.

Note: It does not matter what text is between the question marks in the expression syntax. We can choose any Gender Description data item in the prompt when the report is run.

22. Click Cancel.

23. Click Cancel to return to the report page.
24. Mouse over the **Page Explorer** bar. Notice there are no **Pages** below the **Prompt Pages** yellow folder.
Prompt Pages with Prompts

GOAL: To add a prompt page to the report, and add prompts on the report page.

STEPS:
1. Use the Pre Filter report. Save the report as Prompt Page.
2. Mouse over the Page Explorer bar. Click on the yellow Prompt Pages icon.
3. The Prompt Pages window opens.
4. From the toolbox tab, drag over a Page into the Prompt Page list.
5. Click twice on Prompt Page1.
6. From the toolbox tab, drag over a table and place it inside the Prompt Page Body.

7. Set the number of columns to one and the number of rows to five.
8. Click **OK**.

9. From the toolbox tab, select and drag over a **Text Item** into the first row of the table.

10. In the **Text Item** window, type: Please select an Affiliation Description:

11. Click **OK**.

12. From the toolbox tab, select and drag over a **Value Prompt** into the third row of the table.
13. Name the new prompt “AffiliationPrompt” in the Prompt Wizard window.

14. Click Next >

15. Next to the Package Item field, click on the ellipse.

16. Open the Personal Data Query Subject, and click on the Primary University Affiliation Description data item.

17. Click OK.
18. Leave the **Operator** field set to \(\equiv\).

19. Click **Next >**

20. Accept the default selections, *Notice the Name field displays “Query 2”.* Rename this Query to **Affil Prompt Query**. Click **Finish**.

21. A **Value Prompt** is now on the report page.

22. Click once in **Primary University Affiliation Description prompt box** to activate the Properties window that is located below the Insertable Objects window.
23. In the Properties window, make sure Required is set to Yes.

24. Double click on the text box in the Prompt Page Header. A text box will open.

25. In the Text Box, type “Affiliation Report”.

26. Click OK.

27. Run the report.
28. The Prompt Page will open. From the drop-down list, select the **Miscellaneous** Primary University Affiliation Description.

**Note:** The orange star indicates that you have to select at least one item. The orange arrow indicates that nothing is selected yet.

29. Click **Finish** at the bottom of the page.

30. The report returns rows which only have **Miscellaneous** as a Primary University Affiliation Status.

31. Close the report viewer.

32. Save the report.
Use a Parameter in Formatting

Sometimes there is a need to see the specific prompt value selections on the Report Page, after the report is run. Using a Text Item, the prompt value can be displayed in the header of a report.

**GOAL:** Display the Prompt Value selected in the Report Header.

**STEPS:**

1. Use the Prompt Page report. Save it as Parameter Display

2. Mouse over the Page Explorer bar and click on Page1 under Report Pages.

3. Click once on the Text item in the Header of the Report Page.

4. In the Properties Window, under the Text Source Heading, click once in the Source type field and open the drop down list.

5. Select Report Expressions.
6. Click once in the **Report Expression** field directly below, and open the ellipse to open the **Report Expression** window.

7. In the **Report Expression** window, click the **Parameters** tab.
8. Place the cursor in the **Expressions Definition** window, and type a single quote, then **Affiliations Selected**: then a single quote, then a plus sign. The syntax should look like:

`'Affiliations selected: ' +

- Anything inside the single quotes is exact text. The single quote expression is called a “String”
- The plus sign is code to add another item after the String. In this case, we are adding the **Princeton University Affiliation** parameter.

9. From the **Parameters** tab, drag over **AffiliationPrompt** and place it after the plus sign in the **Expression Definition** window.

10. Validate the Expression Definition.
11. Select any value from the Prompt Window.

12. Click OK.

13. The Expression Definition returns “No errors”.

14. Click OK.

15. Run the report.
16. At the Prompt Window, select **Miscellaneous** and click **Finish**.

---

Please select an Affiliation Description:

* Student  
  Employee  
  Miscellaneous

Select all  Deselect all

17. The chosen Prompt Value, **Miscellaneous**, now displays in the header of the report.

18. Close the report viewer.

19. Save the report.
Identify the Query and Parameter Filter

When a **Prompt** is created on a **Prompt Page**, an additional Query is created, by default. Also, the **Prompt** has a **Parameterized Filter** automatically created.

**Note**: Each time you build a prompt page, a filter is created so that the report data is narrowed down according to the user’s prompt response.

**GOAL**: Identify the new Query and Parameterized Filter created by a Prompt.

**STEPS**:

1. Use the **Prompt Page** report.

2. Mouse over the **Query Explorer** bar. Notice there are two queries.

3. Click on **Query2**. Notice there is one data item there, **Primary University Affiliation Description**. Query 2 was created for the “Affiliation Prompt” in the Prompt Wizard.
4. Mouse over the **Query Explorer** bar again. Click on **Query1**. Query 1 is associated with **Report Page 1**, and contains all the data items on **Report Page 1**.

5. Mouse over the **Page Explorer** bar. Under **Report Pages** click on **Page1**.

6. Click on the **Filters** icon to examine the filter.
7. Open the **Primary University Affiliation Group Description** Parameterized Filter in the Filter window.

8. Notice the question marks in the syntax of the expression. The question marks around “AffiliationPrompt” indicate the prompt.

9. Click **OK** to return to the Filters window.

10. Click **OK** to return to the Report Page.
Prompts – Selecting Multiple Items in the Same Prompt

**GOAL:** To select multiple items in the same prompt.

**STEPS:**

1. Use the current *Prompt Page* report.

2. Return to the prompt page by clicking on the *Page Explorer* bar. Under *Prompt Pages*, click on *Prompt Page 1*.

3. Click in the *Primary University Affiliation Group Description* prompt box.
4. Examine the **Properties** window. Notice that Multi-Select is set to **No**. Change the Multi-Select to **Yes**, which will allow the user to select more than one item if desired.

5. Mouse over the **Page Explorer** bar. Under **Report Pages** click on **Page1**.

6. Click on the **Filters** icon to examine the filter.
7. Open the **Primary University Affiliation Group Description** Parameterized Filter in the Filter window.

![Image of Filter window with expression definition]

8. Change the operator “ = “ to “ in”. The “in” operator allows a person to select more than one value in the associated prompt.

![Image of Filter window with expression definition with “in” operator highlighted]

9. Click **OK** to return to the Filters Window.

10. Click **OK** to return to the Report Page.

11. **Run** the report.
12. When the prompt window appears, hold down the Ctrl key and click on Human Resources and Miscellaneous.

13. Click Finish. To see Miscellaneous rows, click the Bottom link.


15. Save the report.
**Prompt Button**

**GOAL:** To select Last Names.

**STEPS:**

1. Use the **PreFilter** report.

2. Save as **Prompt Button**.

3. Click on the **Last Name** list column header.

4. Click on **Build a Prompt Page** button from the toolbar. Report Studio will automatically build the Prompt Page, the Prompt, and Filter.

5. Save the report.
Exercise

Questions:

1. Can you create a filter on something that is not visible in the report?  If not, why not?  If so, how?

2. If a report has a filter, and you want to run the report and not apply the filter, what do you do?  
   Do you delete the filter or do you skip the filter?  What are the steps to your answer?

3. What is the “operator” that you need to use to filter on more than one item in a column?  Is there more than one operator you can use?

Create the following report:

- Create a list report that is sorted by Country Description in ascending order that shows the following information:
  - ID
  - Last name
  - First name
  - Country Description
  - Street Address 1
  - City
  - State
  - Postal Code
  - Phone Number

- Add a prompt to the report that prompts for more than one Last name.

Answers:

1. Yes.  A Filter can be created by using fields from either the Data Items or Source tab.  If the field used in the Filter is from the data items tab, and it also appears on the Report Page, the field should be cut, not deleted, from the Filter Expression.

2. To run a report and not have the filter applied, you can disable the particular filter in the Filters Window.

3. The Operator “IN” is needed to filter on more than one item in a column.  Example:  [Country Code] in (‘JPN’, ‘HKG’)  The Operator “=” will only return one item from a column.  Example:  [Country Code ] = ‘AUS’  The Operator “between” will return values between a range, as in a range of birthdates.
7. Formatting Reports

Building a Report
Data Formats
Text Formats
Adding Headers and Footers
Formatting the Title
Adding a New Page
Understanding Select Ancestor
Running a report in PDF
Adding Graphics
Building a Report

GOAL: To build a report to use in this chapter.

STEPS:

1. Start a new List report.

2. Create the following report.

3. Save the report as Formatting.

4. Run the report.

5. Close the report viewer.
Data Formats

Text and data within the report can be formatted to make the report easier to read, or to change to a more commonly used format in your organization's reporting structure.

GOAL: To change the Birthdate column to mm/dd/yy format.

STEPS:
1. Using the Formatting report, save the report as Date Formatting.
2. Click once in the Birthdate List Column Body (not the column heading).
3. In the Properties window, click Data Format.
4. Click the ellipsis (the three little dots).
5. Under Format type, click the down arrow and choose **Date**.
6. Under Properties, click **Date Style** and to the right, click the down arrow and choose **Short**.
7. Click **OK** and **Run** the report.

---

<table>
<thead>
<tr>
<th>Last Name</th>
<th>First Name</th>
<th>Country Description</th>
<th>City</th>
<th>State</th>
<th>Birthdate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Doorish</td>
<td>Juan</td>
<td>United States</td>
<td>San Francisco</td>
<td>CA</td>
<td>4/23/73</td>
</tr>
<tr>
<td>Huang</td>
<td>Yat-Tze</td>
<td>United States</td>
<td>San Francisco</td>
<td>CA</td>
<td>3/20/76</td>
</tr>
<tr>
<td>Ho</td>
<td>Brian</td>
<td>United States</td>
<td>Cranbury</td>
<td>NJ</td>
<td>10/18/77</td>
</tr>
<tr>
<td>Lowry</td>
<td>Jason</td>
<td>United States</td>
<td>Princeton</td>
<td>NJ</td>
<td>10/18/77</td>
</tr>
<tr>
<td>Nerenberg</td>
<td>Christopher</td>
<td>United States</td>
<td></td>
<td></td>
<td>9/6/75</td>
</tr>
<tr>
<td>Aidoo</td>
<td>Roy</td>
<td>United States</td>
<td>Stone Harbor</td>
<td>NJ</td>
<td>5/18/78</td>
</tr>
<tr>
<td>Dorfman</td>
<td>Paul</td>
<td>United States</td>
<td>Atlanta</td>
<td>GA</td>
<td>7/16/75</td>
</tr>
<tr>
<td>Cerrigil</td>
<td>Eduardo</td>
<td>United States</td>
<td>Princeton</td>
<td>NJ</td>
<td>4/18/75</td>
</tr>
<tr>
<td>Fambrough</td>
<td>Richard</td>
<td>United States</td>
<td>Westbury</td>
<td>NY</td>
<td>5/18/77</td>
</tr>
<tr>
<td>Ng</td>
<td>Lori</td>
<td>United States</td>
<td>New York</td>
<td>NY</td>
<td>12/15/75</td>
</tr>
<tr>
<td>Dinner</td>
<td>Gerard</td>
<td>United States</td>
<td>Greenfield</td>
<td>WI</td>
<td>12/2/76</td>
</tr>
<tr>
<td>Lippincott</td>
<td>Yoshiaki</td>
<td>United States</td>
<td>Santa Clara</td>
<td>CA</td>
<td>12/31/75</td>
</tr>
<tr>
<td>Olson</td>
<td>Christopher</td>
<td>United States</td>
<td>Houston</td>
<td>TX</td>
<td>7/23/78</td>
</tr>
<tr>
<td>Guibaud</td>
<td>Mary</td>
<td>United States</td>
<td>Franklin Lakes</td>
<td>NJ</td>
<td>2/16/76</td>
</tr>
<tr>
<td>Kaiser</td>
<td>Virgie</td>
<td>United States</td>
<td>Mequon</td>
<td>WI</td>
<td>2/3/75</td>
</tr>
<tr>
<td>Kelsey</td>
<td>Kagari</td>
<td>United States</td>
<td>Cleveland</td>
<td>OH</td>
<td>4/14/78</td>
</tr>
<tr>
<td>Kriva</td>
<td>Heather</td>
<td>United States</td>
<td>North Bergen</td>
<td>NJ</td>
<td>12/19/77</td>
</tr>
<tr>
<td>Pitcher</td>
<td>Towa</td>
<td>United States</td>
<td>Teaneck</td>
<td>NJ</td>
<td>6/27/55</td>
</tr>
<tr>
<td>Nakano-Minami</td>
<td>Mary</td>
<td>United States</td>
<td>Scotch Plains</td>
<td>NJ</td>
<td>3/3/75</td>
</tr>
<tr>
<td>Shin</td>
<td>Cristin</td>
<td>United States</td>
<td>Bronx</td>
<td>NY</td>
<td>9/30/77</td>
</tr>
</tbody>
</table>

8. Close the **Report Viewer**.

9. **Save** the report.
Text Formats

In addition to the data format, the text format of the columns can be changed to make them stand out or to make them easier to read.

GOAL: To change the Country name to a bold font style.

STEPS:

1. Use the current report.

2. Click once in the Country Description List Column Body (not the column heading).

3. From the Style Toolbar, click the Bold button.

4. Run the report.

6. **Save** the report as **Text Formatting**.
Adding Headers and Footers

Report Studio has several options when adding more detail to your report. Page headers and footers and/or list headers and footers can be added to provide additional information to the users about the contents of the report.

Page header and footer includes the following properties: background color, background image, border, box type, conditional style, font, foreground color, horizontal alignment, padding size & overflow, spacing & breaking, text flow and justification, vertical alignment, and white space.

List header appears at the beginning of a list for each grouped item, and is good for presenting carry-forward group totals, or group identifiers.

List footer appears at the end of a list for each grouped item, and is good for presenting group totals.

GOAL: To add a list header to the report.

STEPS:

1. Use the Text Formatting report and save it as Headers.
2. Remove the Country Description, State, and City columns.
3. Add Primary University Affiliation Description and Primary University Group Affiliation Description as the first two columns.
4. Group the Primary University Affiliation column.
5. Click the List Headers & Footers icon.

<table>
<thead>
<tr>
<th>Primary University Affiliation Description</th>
<th>Primary University Affiliation Group Description</th>
<th>Last Name</th>
<th>First Name</th>
<th>Birthdate</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Primary University Affiliation Description&gt;</td>
<td>&lt;Primary University Affiliation Group Description&gt;</td>
<td>&lt;Last Name&gt;</td>
<td>&lt;First Name&gt;</td>
<td>&lt;Birthdate&gt;</td>
</tr>
<tr>
<td>&lt;Primary University Affiliation Description&gt;</td>
<td>&lt;Primary University Affiliation Group Description&gt;</td>
<td>&lt;Last Name&gt;</td>
<td>&lt;First Name&gt;</td>
<td>&lt;Birthdate&gt;</td>
</tr>
</tbody>
</table>
6. Click the Primary University Affiliation Description List Column Header box.

![List Headers & Footers dialog box with Primary University Affiliation Description column selected.]

7. Click OK.

![Example of list with columns for Primary University Affiliation Description, Primary University Affiliation Group Description, Last Name, First Name, and Birthdate.]
8. **Run** the report. Notice that each Primary University Affiliation Description group has a header identifying it.

<table>
<thead>
<tr>
<th>Primary University Affiliation Description</th>
<th>Primary University Affiliation Group Description</th>
<th>Last Name</th>
<th>First Name</th>
<th>Birthdate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee</td>
<td>Employee</td>
<td>Agyeman</td>
<td>Arnette</td>
<td>4/7/69</td>
</tr>
<tr>
<td>Human Resources</td>
<td>Ahmed Michael</td>
<td>9/26/73</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Human Resources</td>
<td>Aikoo Roy</td>
<td>5/18/78</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Human Resources</td>
<td>Alasalo Thomas</td>
<td>11/23/56</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Human Resources</td>
<td>Aliya Mark</td>
<td>4/15/77</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Human Resources</td>
<td>Amobi Maria</td>
<td>1/30/75</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Human Resources</td>
<td>Andlan Gregory</td>
<td>6/28/77</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Human Resources</td>
<td>Andrews Waia</td>
<td>9/12/57</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Human Resources</td>
<td>Anker Katsuaki</td>
<td>1/21/74</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Human Resources</td>
<td>Bakhtiar Joan</td>
<td>9/15/76</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Human Resources</td>
<td>Barmes Steve</td>
<td>4/2/77</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Human Resources</td>
<td>Bayri John</td>
<td>3/24/74</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Human Resources</td>
<td>Bearse Thomas</td>
<td>5/10/77</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Human Resources</td>
<td>Bell Yasuko</td>
<td>2/5/78</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Human Resources</td>
<td>Beltramo Ronald</td>
<td>11/5/78</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Human Resources</td>
<td>Benitez Lydia</td>
<td>11/5/77</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Human Resources</td>
<td>Benton Serge</td>
<td>5/29/76</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Human Resources</td>
<td>Biller Rutha</td>
<td>10/15/78</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Human Resources</td>
<td>Birch Anthony</td>
<td>8/9/77</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Human Resources</td>
<td>Bontelo Randolph</td>
<td>5/2/75</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

9. **Close** the Report Viewer.

10. **Click** [Save](#).
Formatting the Title

Once you add a title, you can easily add formatting for emphasis.

GOAL: To add and format a title.

STEPS:

1. Use the current report and save it as Title.

2. In the Page Header area, double-click on the Double click to edit text to add a title.

3. In the Text window, type All University Affiliations.
4. **Click OK.**

```
<table>
<thead>
<tr>
<th>Primary University Affiliation Description</th>
<th>Primary University Affiliation Group Description</th>
<th>Last Name</th>
<th>First Name</th>
<th>Birthdate</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Primary University Affiliation Description&gt;</td>
<td>&lt;Primary University Affiliation Group Description&gt;</td>
<td>&lt;Last Name&gt;</td>
<td>&lt;First Name&gt;</td>
<td>&lt;Birthdate&gt;</td>
</tr>
<tr>
<td>&lt;Primary University Affiliation Description&gt;</td>
<td>&lt;Primary University Affiliation Group Description&gt;</td>
<td>&lt;Last Name&gt;</td>
<td>&lt;First Name&gt;</td>
<td>&lt;Birthdate&gt;</td>
</tr>
<tr>
<td>&lt;Primary University Affiliation Description&gt;</td>
<td>&lt;Primary University Affiliation Group Description&gt;</td>
<td>&lt;Last Name&gt;</td>
<td>&lt;First Name&gt;</td>
<td>&lt;Birthdate&gt;</td>
</tr>
</tbody>
</table>
```

5. **Run** the report.

![All University Affiliations](image)

6. **Close** the Report Viewer.

7. Click on the text **All University Affiliations** so that it is selected. (The Properties window should read “Text Item” in the title bar.)

8. From the **Style** Toolbar, click format the font to Arial, the font size to **24pt**, and click the **Bold** icon to set the text to bold.

![Style Toolbar](image)
9. Click OK and then Run the report.

10. Click Save.
Adding a New Page

Adding a new page enables you as a report user to add the page either as a title page before the body of the report, or as a secondary page that may serve as an additional reporting page, or as a summary.

GOAL: To add an introductory Title page.

STEPS:

1. Use the current report and save it as **Title page**.

2. From the Report Studio Main Menu bar, click **View > Report Pages**.

3. From the toolbox tab drag over a Page item and place it above **Page1** under the **Report Pages** header.
4. The new **Page2** appears above **Page1** in the list.

5. In the Properties Window, under Miscellaneous heading, locate the Name field.

6. Rename Page2 to “Title Page”.

7. Under the **Report** Pages heading, double-click on **Title Page**.

8. Drag and drop the **Table** into the blank page.
9. For columns, type 1, and for rows, type 3.

10. Click OK.

11. Save the report.
Understanding Select Ancestor

Using the Select Ancestor button allows the user to select a group of related elements in a report, to change their properties as a whole.

GOAL: To make an entire table one type of format.

STEPS:

1. Use the current Title Page.
2. Click once in the third row of the table on the Title Page.
3. In the Properties Section, the Select Ancestor is at the Table Cell level.
5. Click on the **Select Ancestor** button. All ancestors above the **Table Cell** level appear.

6. Select **Table**. Notice the entire table is now selected.

7. From the **Style** menu, set the **Bold** and **Center** properties for the table.

8. From the Toolbox tab, drag over a **Text** item and place it in the third row of the table.

9. Type “Affiliation Report - For All Departments”.
10. Click **OK**. Notice how the new text item is automatically bold and centered within the Table.

11. Run the Report. The **Title Page** displays first.
12. Click **Bottom** to navigate to the next Report Page.

13. Close the report viewer.

14. Save the report.
Running a report in PDF

You may run your reports in various formats, including PDF, and change your parameters for printing purposes.

**GOAL:** To run the report as PDF and change printing parameters.

**STEPS:**

1. Click the **arrow** next to the **Run** icon and select **Run Report (PDF)**.
2. The report is shown in PDF format. Click the **down-arrow** at the bottom of the screen to move to the second page.

3. Close the report viewer.

4. From the Report Studio Main Menu Bar, click **File** &gt; **PDF Page Setup**.

5. Set the Orientation to **Landscape**.

6. Click **OK**.

7. Run the report to PDF. Notice, the **RUN** button is already set to deliver the report in PDF format:
8. The report will open in PDF and with a landscape orientation.


10. Save the report.
Adding Graphics

Graphics can be added to a report, however, the graphic image must be saved on the Cognos Server. Please contact the Data Warehousing and Integration Team (information-warehouse@princeton.edu) to add images to the Cognos Server.
8. Creating Crosstab & Mail merge/Letter Reports

Crosstab Reports

Converting a List Report into a Crosstab

Crosstab Template

Nested Crosstabs

Crosstabs with Totals

Creating a Mail merge/Letter-type Report Using a Blank Report
Crosstab Reports

Crosstab reports, or Pivot Tables, are useful for comparative analysis because they summarize data and display the results in a two-dimensional grid.

Similar to list reports, Crosstab reports show data in columns and rows. However, the values at the intersection of rows and columns show summarized information rather than detailed information.

Crosstabs must include at least three query items: one on rows, one on columns, and one to serve as a measure or performance indicator defining what the data represents. In a crosstab report, data can be nested to compare information using more than one query item in a column or in a row.
Converting a List Report into a Crosstab

GOAL: Create a simple list report and convert it to a crosstab report.

Note: Converting a list report to a crosstab is accomplished by selecting the column(s) that you want to be the column(s) in the crosstab.

STEPS:

1. Create a report with the following fields:
   • Country Description
   • Primary University Affiliation Description
   • Count ID

2. Group Country Description and Primary University Affiliation Description.

3. Run the report.
4. Close the **Report Viewer**.

5. Highlight the **ID** List Column Body.

6. In the Properties Window, under the **Data Item** heading, set the **Aggregate Function** to “Count”.

7. In the Properties Window, under the **Data Item** heading, set the **Rollup Aggregate Function** to “Total”. Setting the **Rollup Aggregate Function** to “Total” on the “ID” field is necessary for the list to become a crosstab.

8. Click on the **Primary University Affiliation Description** List Column Header.
9. From Report Studio Main Menu bar select **Structure > Pivot List to Crosstab**.

**Note:** Converting a list report to a crosstab is accomplished by selecting the column(s) that you want to be the column(s) in the crosstab.

10. The report layout has changed from a list report to a crosstab with **Primary University Affiliation Description** as the columns, **Country Description** as the rows, and **ID** as the measure.
11. **Sort Ascending** on Country Description.
12. **Run** the report.

```
<table>
<thead>
<tr>
<th>ID</th>
<th>Employee</th>
<th>Student</th>
<th>Miscellaneous</th>
</tr>
</thead>
<tbody>
<tr>
<td>Australia</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Austria</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Belgium</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Bulgaria</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Canada</td>
<td>5</td>
<td>9</td>
<td>18</td>
</tr>
<tr>
<td>Costa Rica</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Germany</td>
<td>1</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Hong Kong</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>India</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Israel</td>
<td>1</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Jamaica</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Japan</td>
<td>2</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Korea, Republic of</td>
<td>2</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>Kuwait</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Malaysia</td>
<td>1</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Mauritius</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Mexico</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Morocco</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>New Zealand</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Panama</td>
<td></td>
<td></td>
<td>1</td>
</tr>
</tbody>
</table>
```

May 4, 2010

13. **Close** the Report Viewer.

14. **Save As:** **Crosstab.**

**EXERCISE:**

- Create the same report by clicking **New** and selecting **Crosstab**.
- Drag the appropriate columns to the rows, columns and measures.
- Sort Ascending on the column.
- Select ID in the measures area and in the Properties window, under Data Item, change Aggregate Function to Count.
Crosstab Template

GOAL: Use the Cognos Crosstab Template to create a Crosstab report.

Linear Process: Create a report which counts how many Employees are either Male or Female, for any given Affiliation.

STEPS:

1. Start a new report, and select Crosstab from the Template Menu.

2. Click OK.
3. From the **Source** tab in the Insertable Objects window, click and drag **Primary University Affiliation Description** into the **Rows** area of the Crosstab.

4. From the **Source** tab in the Insertable Objects window, click and drag **Gender Description** into the **Columns** area of the Crosstab.
5. From the **Source** tab in the Insertable Objects window, click and drag ID into the **Measures** area of the Crosstab.

**Note:** After placing a field into the **Measures** area of the Crosstab report, Report Studio’s formatting will display numbers <1234> in the rows. This is just a Report Studio formatting layout, and does not represent actual data.

<table>
<thead>
<tr>
<th>ID</th>
<th>&quot;Gender Description&quot;</th>
<th>&quot;Gender Description&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Primary University Affiliation Description&quot;</td>
<td>&lt;#1234#&gt;</td>
<td>&lt;#1234#&gt;</td>
</tr>
<tr>
<td>&quot;Primary University Affiliation Description&quot;</td>
<td>&lt;#1234#&gt;</td>
<td>&lt;#1234#&gt;</td>
</tr>
</tbody>
</table>

6. Click inside the **Measures** area.

<table>
<thead>
<tr>
<th>ID</th>
<th>&quot;Gender Description&quot;</th>
<th>&quot;Gender Description&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Primary University Affiliation Description&quot;</td>
<td>&lt;#1234#&gt;</td>
<td>&lt;#1234#&gt;</td>
</tr>
<tr>
<td>&quot;Primary University Affiliation Description&quot;</td>
<td>&lt;#1234#&gt;</td>
<td>&lt;#1234#&gt;</td>
</tr>
</tbody>
</table>

7. In the **Properties** area, change the **Aggregate Total** to “Count” and the **Rollup Aggregate Total** to “Total”.

<table>
<thead>
<tr>
<th>Data Item</th>
<th>Type</th>
<th>Data Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>ID</td>
<td></td>
</tr>
<tr>
<td>Label</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Expression</td>
<td>[Report Net Training Data].[Personal Data].[ID]</td>
<td></td>
</tr>
<tr>
<td>Aggregate Function</td>
<td>Count</td>
<td></td>
</tr>
<tr>
<td>Rollup Aggregate Function</td>
<td>Total</td>
<td></td>
</tr>
</tbody>
</table>

8. Run the report. Notice that totals now appear in the **Measures** section.

<table>
<thead>
<tr>
<th>ID</th>
<th>Unknown</th>
<th>Male</th>
<th>Female</th>
</tr>
</thead>
<tbody>
<tr>
<td>Student</td>
<td>475</td>
<td>15</td>
<td>10</td>
</tr>
<tr>
<td>Miscellaneous</td>
<td>249</td>
<td>43</td>
<td>16</td>
</tr>
<tr>
<td>Employee</td>
<td>213</td>
<td>25</td>
<td>13</td>
</tr>
</tbody>
</table>


10. Save the report as “Gender Count Crosstab”.

Report Studio Introduction
Nested Crosstabs

GOAL: Nest data in a crosstab report to compare information using more than one query item in a column or row.

STEPS:

1. Open the Crosstab report.

2. Save it as Nested Crosstab. Currently, the Country Description data item represents the rows, and the Primary University Affiliation Description data item represents the columns.
3. Click the **Swap Rows and Columns** icon. After this swap, the **Country Description** data item represents the columns, and the **Primary University Affiliation Description** data item represents the rows.

4. From the **Source** tab in the Insertable Objects window, click and drag **Primary University Affiliation Group Description** to the drop zone after the **Primary University Affiliation Description** item and release the mouse click.

5. The columns are nested.
6. Run the report. Scroll to the right to see all the countries.

7. **Close** the Report Viewer.

8. **Save As:** Nested Crosstab.
Crosstabs with Totals

GOAL: Add totals to the crosstab report.

STEPS:

1. Use the Nested Crosstab report.

2. Highlight the measure in the crosstab report.

3. Click the down arrow on the **Aggregate** icon and select **Total**.

4. Totals are added to the report.
5. **Run** the report.

6. **Close** the Report Viewer.

7. **Click** **Save**.
Creating a Mail merge/Letter-type Report Using a Blank Report
Using Report Studio, a report can be formatted to appear as a letter. The report can then generate one letter for one or many people.

**GOAL:** To write a report in a letter-type format using a Blank report template.

**STEPS:**
1. From within Report Studio, click on **File > New Report**.
2. Choose a **Blank** report format.
3. Mouse over the **Query Explorer**. Click on the **Queries** link.
4. In the new window, from the **Toolbox** tab, drag over a **Query** item and place it into the canvas.
5. Mouse over the **Page Explorer** and click on the **Page 1** under **Report Pages**.
6. Click anywhere on the canvas.

7. Select the Ancestor button.

8. Select Page.

9. In the Query Property, select Query 1. (Query 1 is the Query created in the Step 4 above.)

10. The formatting on the canvas can now begin, following the exact type of letter being created. From the Toolbox tab, drag over a Table and place it into the canvas.

11. Give the Table: 1 column, 10 rows.

12. Click OK.
13. From the **Toolbox** tab, drag over a **Date** item and place it into the first row of the **Table**.

![Diagram of Toolbox and Table]

14. Click on the **Table Row**. From the upper-level toolbar, click on the **Right-align** button to align the **Date** object to the right side of the table row.

![Diagram of Right-align button]

15. From the **Toolbox** tab, drag over a **Text** Item and place it into the second table row.

16. Insert twenty or more spaces into the **Text** Item. Click **OK**.

**NB:** Inserting a Text item with blank spaces inserts a blank row into the report, so when printed, the report shows a space between lines in the ‘letter’.

![Text Item with blank spaces]

Report Studio Introduction  pg 223
17. From the **Source Tab**, from the **Personal Data** Query Subject, drag in the **First Name** field and place it into the third row of the table.

18. Double-click on the **First Name** field in the Table.

19. In the new window, concatenate the text “Dear “ before the First Name field and the text “,” after the First Name field, using the **double-pipe** symbols, found on the **Functions** tab, under the **Operators** folder.

   ![Image](image.png)

   'Dear ' || [Report Net Training Data].[Personal Data].[First Name] || ','
20. **Validate** the Expression by clicking the **Validate** button to ensure there are no errors in the Expression.

21. When **No errors** are received, click **OK**.

22. **Run** the report to **PDF**. One page will appear with the current date displayed and a salutation.

23. Close the PDF preview window to return to Report Studio.

24. To have a page, or letter, for each unique person, a unique identifier must be placed into Query 1. Usually this unique identifier is an Employee ID or Student ID, or some other unique identifier. Mouse-over the **Query Explorer** and click on **Query 1**.
25. From the **Personal Data** Query Subject, drag over the ID field and place it in the **Data Items** section.

26. Mouse over the **Page Explorer** and click on the yellow **Report Pages** text, next to the yellow envelop.

27. From the **Toolbox** tab, drag over a **Page Set** and place it above **Page1** in the Page Explorer.
28. Drag Page1 into the Detail Pages folder, so that Page1 appears below the Detail Pages folder.

29. Click once on Page Set1.

30. In the Properties section, click on the Query property.

31. Click the drop-down arrow which appears next to Query 2. Select Query 1.

32. Also in the Properties section, click on the Grouping and Sorting property.

33. Click the ellipses button.
34. In the new window, drag ID under the Overall section.

35. Click OK. The Report Pages area should now look as below:

36. Mouse over the Page Explorer and click on Page 1.

37. From the Toolbox tab, drag over a Text box item and insert it into the fourth row of the table, to place a space between the Letter’s salutation and the first line of text. In the Text Item, type twenty or more spaces. Click OK

38. From the Toolbox tab, drag over a Text box item and insert it into the fifth row of the table. In the Textbox, type the following text, being sure to place one space after the word “the”:

Congratulations on your new position within the
39. Click OK.

40. From the Source tab, drag over the Dept Name field from the Job Data Query Subject and place it next to the Text box.

41. From the Toolbox tab, drag over a Text box item and place it into the fifth row, after the Dept Name field. Into the Textbox, type the following text, being sure to place one space before the word “department”.

   department.

42. From the Toolbox tab, drag over a Text box item and insert it into the sixth row of the table, and type twenty or more spaces.

43. Click OK

43. From the Toolbox tab, drag over a Text box item and insert it into the seventh row of the table, and type the following text:

   This is the Citizenship information you provided upon your acceptance of your position. If this information is not correct, please contact the Human Resources Department.

44. From the Toolbox tab, drag over a List object and place it into the eighth row of the table.

45. Click anywhere in the List object. From the Properties menu, click the Ancestor button and select List.

46. In the Query Property, click on the drop-down arrow and select Query 1.

47. From the Source tab, drag over the Citizenship Status Description and Country of Citizenship Description fields from the Citizenship Data Query Subject and place them into the List.
48. Run the report. There should be twenty pages returned, with each person having a department displayed in the first line of the Letter, and their Citizenship information in the List below.

Jan 31, 2014

Dear Robin,

Congratulations on your new position within the OIT department.

This is the Citizenship information you provided upon your acceptance of your position. If this information is not correct, please contact the Human Resources Department.

<table>
<thead>
<tr>
<th>Citizenship Status Description</th>
<th>Country of Citizenship Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Citizen</td>
<td></td>
</tr>
</tbody>
</table>

49. From the Toolbox tab, drag over a Text box and insert it into the ninth row of the table, and type twenty or more spaces. Click OK

50. From the Toolbox tab, drag over a Text box and insert it into the tenth row of the table, and type the following text:

Thank you.

51. Run the report. The letters are finished.

Note: There is no spell-check feature in Report Studio.